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1 INTRODUCING XBUILDER

Xbuilder’s primary role in the Vertigo Suite is to quickly and accurately build multiple 
instances of template-based or pre-rendered graphics for playout. Xbuilder is also allows 
you to prepare the new graphics for playout by verifying quality, previewing playout and 
organizing the graphics into playlists.

While the remaining chapters provide instructions for how to use Xbuilder, the following list 
provides a brief overview of Xbuilder’s main functions:

• Create and populate graphics pages from a master template

Templates created in Xstudio lock down a graphics’ layout. With no need to recreate 
the graphic’s layout, Xbuilder can use templates to quickly create multiple instances of 
the graphics where the content is specific to the broadcast. These new graphics called 
pages are saved as individual assets whose layout is linked to the template. See page 
3-1 for more information.

• Render templates to a clip file for the purposes of previewing or playout

Xbuilder can render the playout of templates into various video clip formats, so that you can 
preview the graphics playout, or use the resulting clip file to playout the pre-rendered 
graphic on a video server or Vertigo playout device. See page 4-1 for more information.

• Perform quality control and media check of pre-rendered graphics files

Xbuilder’s Make List feature (QC workflow) allows you to preview and validate 
(approve or reject) the pre-rendered graphics that the After Effects Plug-in and the 
Make List file created and ingested into the Xmedia Server.

Once the graphics are approved and published to the device(s), Xbuilder’s Air List feature 
(MC workflow) allows you to quickly preview and verify that all of the approved graphics 
have actually been published to the correct devices. See page 5-1 for more information.

• Create sequential playlists to be played out in Xplay

Xbuilder allows you to build playlists, which are ordered sequences of program clips 
and branding and promotional graphics elements (i.e. pages, scenes or clips). The 
resulting playlists can be edited and played back using the Vertigo Suite’s Xplay. See 
page 6-1 for more information.

• Create rundowns and segments for newsroom applications

Similar to sequential playlists, Xbuilder can create rundowns and segments, which are 
ordered lists of the pages, scenes and clips that can be brought into newsroom 
applications. See page 7-1 for more information.



Xbuilder User Manual 2-1

2 GETTING STARTED WITH XBUILDER

This chapter provides you with information about installing and licensing the Xbuilder 
software on a client workstation. Additional information and instructions are provided for 
performing a basic setup and configuration of the Xbuilder software.

Once you have completed the installation and quick setup, Xbuilder will be properly 
configured to create and save pages, render graphics to clips and create playlists.

This chapter is organized into the following topics:

• “Installation and licensing information” on page 2-2

• “Starting Xbuilder and connecting to the Xmedia Server” on page 2-3

• “Overview of Xbuilder’s user interface” on page 2-4

• “Configuring Xbuilder’s settings” on page 2-6

• “Adding and configuring a Preview device” on page 2-7

• “Configuring a device for the verification of playlist elements” on page 2-9
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Installation and licensing information
Xbuilder is packaged with the Vertigo Suite software installation wizard. It can be installed 
as part of the full installation or as an individual (standalone) component. In both cases, you 
simply need to run the installation wizard on a workstation that is on the same network as 
the Xmedia Server.

Information regarding the Vertigo Suite’s hardware and network requirements, as well as 
instructions for installing and/or upgrading Xbuilder, are available in the Vertigo Suite’s 
Release Notes, which can be downloaded from the Support Portal web site.

To operate in its full capacities, Xbuilder requires that four (4) software application licenses 
(listed below) be installed and validated on the Xmedia Server. Therefore, once Xbuilder is 
installed, you must contact our Technical Support team (support@miranda.com) to 
request a license key. Then you must apply and validate the licenses using the 
XmediaServer Control Panel. Instructions for acquiring and validating licenses are also 
provided in the Vertigo Suite’s Release Notes.

License name Description

Xbuilder
The Xbuilder license is required to open and operate the base 
features and functionality of the Xbuilder application.

XGSoftware
The XG Software license is required to preview graphics using the 
VX-Preview (Software CG) application. See page 3-11 for more 
information.

XGEncode

The XG Encode license is required to use Xbuilder’s Render to File 
feature, which renders and saves the playout of a template, page, 
and/or scene to a file in various clip formats. See page 4-1 for more 
information.

XGEncodeforPlayout
The XG Encode for Playout license is required to render pages 
and/or scenes to playout server compatible formats (XDCAM and 
IMX compatible MXF files). See page 4-3 for more information.

QC

The QC license is required to use Xbuilder’s Quality Control (QC) 
workflow (OPEN MAKELIST feature). The QC workflow allows you to 
preview and validate graphics before they are published to the target 
devices and taken to air. See page 5-1 for more information.
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Starting Xbuilder and connecting to the Xmedia Server

When you initially launch Xbuilder, a dialog box appears and asks you to configure the 
server location. As a client application, Xbuilder must be connected to the Xmedia Server, 
which is the centralized asset management server for Vertigo applications and devices.

Since you have only just installed Xbuilder, the first task that you must do is to connect 
Xbuilder to the Xmedia Server.

To start Xbuilder and connect to the Xmedia Server:

1. Click START>PROGRAMS>VERTIGOXMEDIA>XBUILDER.

2. When the message asking you to configure the server location, click the YES button. 

The SETTINGS dialog box appears.

Figure 2-1. Settings dialog box

3. Click SERVERS in the tree view at left. This displays the settings related to the Xmedia 
Server (see page 9-15 for more information about Xbuilder’s Server settings).

4. In the XMEDIASERVER IP ADDRESS field, replace <server IP> with the IP address of 
the machine hosting the Xmedia Server.

5. Unless the port number was changed when the Xmedia Server was installed, the 
default in the XMEDIASERVER PORT field will be correct. If it was changed, enter the new 
number.

6. Click OK.

Xbuilder launches. If the program does not launch, consult your system administrator. 
The problem could be due to one of the following:

• The IP address or port was entered incorrectly.

• The machine hosting the Xmedia Server is down.

• The Xmedia Server is not running on the host machine.

• The machine is not connected to the network.
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Overview of Xbuilder’s user interface
Xbuilder provides an interface provides you with the tools and features required for 
accomplishing various tasks like creating and populating pages, rendering graphics to a file 
or building playlists.

Figure 2-2 and the following descriptions provide an overview of Xbuilder’s main interface 
features and components. Information and instructions for how to use each interface 
component are provided in within the applicable tasks in further chapters.

Figure 2-2. Xbuilder interface

1. Main menus - Located along the top of the interface, these menu commands provide 
access to most of Xbuilder's settings and administrative functions. See “Appendix A - 
Quick reference to Xbuilder’s menus & toolbars” on page 8-1 for more information.

2. The upper portion of the Xbuilder interface changes according to what type of project 
you are working on: playlist, segment, rundown or timeline.

• Playlist Editor - The workspace where pages, templates, scenes and clips 
can be organized into a sequential playlist. See page 6-2 for full details on 
using the Playlist Editor.

• Segment window - Very similar to the Playlist Editor, the Segment window 
allows you to build a portion of a sequential playlist to be used in a rundown. 
See page 7-4 for full details on using the Segment window.

1

2

3

4

5

6
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• Rundown Editor - The workspace for creating a sequential rundown playlist 
using segments, pages, clips, scenes and template assets. See page 7-6 for 
full details on using the Rundown Editor.

• Timeline Editor - The Timeline Editor allows you to create and edit 
automated promos by assembling and editing episodic clips, graphics, and 
audio elements within a timeline interface.

3. Asset Browser - Located in the lower left-hand portion of the interface, the Asset 
Browser provides a tree view of the asset categories on the connected Xmedia Server. 
When you select a category or sub-category, the assets stored within the category are 
displayed in the panel to the right of the Asset Browser (Template Editor). You can 
display or hide the Asset Browser by pressing CTRL+A, or by selecting Asset Browser 
from the View menu.

4. Template Editor - Its main function is to provide a canvas for displaying and editing 
the variable fields on a open pages, templates and scenes. Its toolbar buttons provide 
access to commands and features tat can be applied to the displayed asset.

A secondary function of this interface panel, is to display the contents of the selected 
category from the Asset Browser. The assets from a selected category can be viewed 
in proxy or list view mode.

5. Favorites Browser - Located in the lower right-hand portion of the interface, the 
Favorites Browser provides a quick drag-and-drop area where frequently used 
templates, pages, scenes and clips can be stored for easy access.

6. Status bar - Located along the bottom of the Xbuilder window, the status bar provides 
process update messages (left), server connection identification (center), and preview 
device connection status (right).
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Configuring Xbuilder’s settings
Although Xbuilder’s default settings are appropriate for most operating circumstances, you 
may want to customize the look and behavior of the application using Xbuilder’s settings. 
Note that modifying these settings is entirely optional.

Changes to Xbuilder settings are made within the SETTINGS dialog box, which can be 
accessed by selecting TOOLS>SETTINGS from the Xbuilder menu commands. 

This SETTINGS dialog box contains a tree-structure of thematic settings. Each of the settings 
is defined in the following sections:

• “General settings” on page 9-2

• “Display settings” on page 9-4

• “Template Favorites settings” on page 9-6

• “Automation settings” on page 9-7

• “Playlist Ingest settings” on page 9-8

• “Place Holders settings” on page 9-9

• “Merge List settings” on page 9-10

• “Logging settings” on page 9-11

• “Render To File settings” on page 9-12

• “Timelines settings” on page 9-13

• “Work Orders settings” on page 9-14

• “Servers settings” on page 9-15

• “Playlist > Basic settings” on page 9-16

• “Playlist > Highlight settings” on page 9-17
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Adding and configuring a Preview device
In order to use Xbuilder’s features for previewing the playout (page 3-11) and/or render a 
page/scene to file (page 4-1), you must specify which device Xbuilder will use to perform 
these tasks. In most cases, a Vertigo Software CG device is used for previewing and 
rendering to file in Xbuilder. 

NOTE

The XGSOFTWARE license is required to fully use the preview feature.

To add and connect Xbuilder to a Preview device:

1. Open the Device Configuration window by selecting TOOLS>DEVICE MANAGER. 

2. In the DEVICE CONFIGURATION window, select the ADD button:

Figure 2-3. Device Configuration dialog box

3. The DEVICE CONFIGURATION windows expands to reveal two tabs (GENERAL and ADVANCED) 
with settings for identifying the device’s configuration.

Figure 2-4. Add Device Configuration section
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4. Specify the appropriate General Device Configuration settings:

5. Click APPLY.

6. In the DEVICE CONFIGURATION dialog box, click in the cell to the right of Preview. 

7. Select the device from the table at left and then click . 
The device now appears next to the PREVIEW box at right.

8. Click CLOSE.

When Xbuilder successfully connects to the preview device, the LED in the lower right 
corner of the Xbuilder window is green and when disconnected, it is red.

Device name The name of the selected device. This can only be modified when 
adding a device.

Device alias An alternative name for the selected device on your network.

Description An optional field that lets you label the device to distinguish it from other 
similar devices at your facility (for example).

Device Type Identifies the type of device that these settings apply to. Select 
PREVIEW (or other device) for Software CG devices.

Control IP The network location (IP address) or hostname of the selected device. 
The host must be available on the network.

Control Port The networking port that serves as a channel for sending commands to 
and from the device.

Publish IP The network location (IP address) or hostname of the selected device. 
The host must be available on the network.

Publish Port The networking port that serves as a channel for publishing assets. 
Typically, this value is set to 15000.

NOTE: This value must correspond with the port used by the 
XpublishAgent on the output device.
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Configuring a device for the verification of playlist 
elements

Xbuilder can be configured to manually or automatically verify the elements of a playlist 
have been published to specified devices. Elements that have not been published are 
identified and highlighted in the playlist so that they can be published. For this verification 
step to be accomplished, the target devices that will be checked must first be assigned in 
the Device Manager.

To specify a device for the verification of playlist elements:

1. Open the Device Manager by selecting TOOLS>DEVICE MANAGER. 

The DEVICE CONFIGURATION dialog box appears.

Figure 2-5. Device Configuration dialog box

2. Verify that the intended output device is listed in the DEVICE CONFIGURATION dialog box. 
If it is not, then you must add it to the device list.

a. In the DEVICE CONFIGURATION window, select the ADD button.

b. The DEVICE CONFIGURATION windows expands to reveal two tabs (GENERAL and 
ADVANCED) with settings for identifying the device’s configuration.

c. Specify the appropriate General Device Configuration settings:

Device name The name of the selected device. This can only be modified when adding a device.

Device alias An alternative name for the selected device on your network.

Description An optional field that lets you label the device to distinguish it from other similar 
devices at your facility (for example).

Device Type Identifies the type of device that these settings apply to. Choose from the following: 
VERTIGOXG, INTUITIONXG, PREVIEW (OR OTHER DEVICE), IMAGESTORE, INTUITION, 
FTP, LGK, DSK, HMP, or OTHER.

Control IP The network location (IP address) or hostname of the selected device. The host 
must be available on the network.

Control Port The networking port that serves as a channel for sending commands to and from the 
device.
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d. Specify the appropriate Advanced Device Configuration settings:

Publish IP The network location (IP address) or hostname of the selected device. The host 
must be available on the network.

Publish Port The networking port that serves as a channel for publishing assets. Typically, this 
value is set to 15000.

NOTE: This value must correspond with the port used by the XpublishAgent on the 
output device.

Clip Template The name of the template that is used to play out clips. The clip template’s control-
side must have a texture linked to a scene-side clip object. Use the  button to 
navigate to the Clip template. 

Note that among the Vertigo Suite’s system templates are valid clip templates for 
various scene formats. The system templates are export files that are stored in the 
following directory: Program Files\VertigoXmedia\Apps\Support. Once 
imported into the Xmedia Server, the templates are stored in the 
TEMPLATES>SYSTEM TEMPLATES category.

The Clip Template field only appears when one of the following device types is 
selected: Vertigo XG, Intuition XG, Preview (and other devices), or Other.

Cel Template The name of the template used to play out cel animations. The cel template’s 
control-side must have a texture linked to a scene-side clip object. Use the  button 
to navigate to the Cel template.

Note that among the Vertigo Suite’s system templates are valid Cel templates for 
various scene formats. The system templates are export files that are usually stored 
in the following directory: Program Files\VertigoXmedia\Apps\Support. 
Once imported into the Xmedia Server, the templates are stored in the 
TEMPLATES>SYSTEM TEMPLATES category.

The Cel Template field only appears if one of the following device types is selected: 
Vertigo XG, Intuition XG, Preview (and other devices), or Other.

Image Template The name of the template used to play out images. The image template’s control-
side must have a texture linked to a scene-side clip object. Use the  button to 
navigate to the Image template.

Note that among the Vertigo Suite’s system templates are valid image templates for 
various scene formats. The system templates are export files that are usually stored 
in the following directory: Program Files\VertigoXmedia\Apps\Support. 
Once imported into the Xmedia Server, the templates are stored in the 
TEMPLATES>SYSTEM TEMPLATES category.

The Image Template field only appears if one of the following device types is 
selected: Vertigo XG, Intuition XG, Preview (and other devices), or Other.
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e. Click APPLY.
The device is added to the Device list in the Device Configuration dialog box.

3. In the DEVICE CONFIGURATION dialog box, select the text box to the right of DEVICE1.

4. Select the device name from the table and click . 

The device appears in the box on the right side with its name in the DEVICE1 field. 

5. Click CLOSE on the Device Configuration dialog box.

6. Restart Xbuilder and ensure that the device was added to the DEVICE FOR VERIFY drop-
down list in the upper-right corner of Xbuilder’s Playlist Editor toolbar.

External Keyer Allows you to associate another device with the current device. This setting is 
specifically used when the CG output is keyed over the ImageStore output. In this 
way, specific commands can be sent to the ImageStore (the External keyer) when 
specific things are done on the CG.

Publish Master Lets you select a master device.
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3 CREATING, EDITING AND PREVIEWING 
PAGES AND/OR SCENES

In the Vertigo Suite workflow, Xstudio is used to author scenes, which display graphical 
elements (i.e. text, images, video clips, and cel animations) on air. Scenes can be 
standalone or they can be associated with a template. A template is an interface that lets 
operators control and edit parts of the scene without disturbing the scene’s layout or 
formatting.

The benefit of using template-based graphics is that once you have created a scene and 
template in Xstudio, rather than recreating the control and layout for similar projects, you 
can use the template and scene in Xbuilder to create multiple instances of the graphics 
(called pages) by simply changing the content (i.e. enter the new text, images, clips, and/or 
animations specific to the broadcast). Also note that no matter how many times the page is 
edited, the page retains its ties to the template that it was created from. The advantage of 
this is that changes to the template are easily propagated to all of the pages that were built 
from using that template.

Figure 3-1. Workflow for populating templates and creating pages

There are actually two types of pages that can be created using Xbuilder: shared or embedded. 
Both types of pages provide the same playout performance in a playlist. The main consideration 
that should be taken into account is whether the page is intended to be included in only one or 
many playlists.
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• Shared pages are the preferred type of page as they are created directly from an 
existing template and they are saved to the Xmedia Server as distinct assets. Shared 
pages can be used in many different playlists as a common item.

• Embedded pages are most often created from another existing page. Unlike shared 
pages, embedded pages only exist within a playlist, and it is the playlist that is saved 
as a whole to the Xmedia Server. As a result, the individual page does not exist 
anywhere else, not even in the PAGES root category of the Asset Browser. Embedded 
page can be reused outside of its playlist if its playlist is inserted or appended to 
another playlist, or if the page converted into a shared page using the SAVE AS SHARED 
PAGE command. See page 6-7 for instructions on creating and adding embedded 
pages to a playlist.

The following sections provide instructions for using Xbuilder to create and populate 
graphics pages and scenes, either individually from a template/scene or as a batch using a 
Merge List file:

• “Creating an individual shared page from a template” on page 3-3

• “Creating pages and/or scene using a Merge List” on page 3-4
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Creating an individual shared page from a template
Shared pages are graphics created as an instance of an existing template. They are stored 
on the Xmedia Server as an distinct assets and can be used in many different playlists as 
a common item. Like all pages, the shared page’s formatting is linked to the original 
template (changes to the template’s formatting are automatically applied to the page). The 
following instructions describe how to create an individual shared page.

To create a new shared page from a template:

1. Open Xbuilder.

2. In the Asset Browser, navigate through the TEMPLATES root directory until you see the 
desired template listed in the Template Editor.

3. Double-click the template, or right-click on the template listed in the Template Editor 
and select the OPEN command from the context menu.

The template opens in the Template Editor.

4. Set or edit the variable fields in the template as required (see “Editing a page or scene’s 
content elements” on page 3-10 for assistance).

5. Select the FILE>SAVE AS A SHARED PAGE command.

The SAVE PAGE dialog box appears (figure 3-2).

Figure 3-2. The Save As Shared Page command opens the Save Page dialog box

6. In the NAME field enter a new name for the page.

7. In the RECALLID field enter a unique a unique alpha-numeric identifier that can be used 
in Vertigo Suite applications (i.e. Xbuilder, Xplay) to quickly call up the specific page. 
(optional)

8. Enter your name in the AUTHOR field (optional).

9. Enter a short description of the page in the DESCRIPTION field (optional).

10. Link the page to the Pages root category or to sub-categories by selecting the check 
box for each place where you want the page to be accessible from.

11. Click OK to save the page and exit the dialog box.
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Creating pages and/or scene using a Merge List
Xbuilder’s Merge List feature (ACTIONS>OPEN MERGE LIST) allows you to create multiple 
pages and/or scenes from a single Merge List file (spreadsheet or XML file). Acting as the 
data source, the Merge List file provides Xbuilder with the information it needs to create new 
instances of pages/scenes from existing template and scene assets.

The following table describes the Merge List workflow for creating new pages and/or scenes:

Step Task Description

1 Configure Xbuilder’s Merge List settings

Specify the default categories in which new pages and scenes will be stored. Since scenes will 
only be moved to the default category after they have been approved, you must also specify a 
temporary category for new scenes. 

1. Open Xbuilder and select TOOLS>SETTINGS>MERGE LIST. 

2. For each of the settings, select the  button and select a destination category. 
See “Merge List settings” on page 9-10 for more information.

2 Create the templates and scenes in Xstudio

In Xstudio, create or verify the existence of the templates and scenes that you want to create 
the new pages and scene from.

3 Create the Merge List file

Xbuilder generates the new pages and/or scenes based on the data provided in the Merge List 
file. The Merge List file can be in XML format or an Excel spreadsheet. The following sections 
provide instructions for creating an appropriate Merge List file:

• “Creating Merge List file in Microsoft Excel” on page 3-5

• “Creating an XML Merge List file” on page 3-6

4 Load the Merge List file in Xbuilder

When a Merge List file is loaded, Xbuilder generates the new pages and/or scenes based on 
the data provided in the Merge List file. After being processed, the new pages and/or scenes are 
added to a playlist in Xbuilder’s Playlist Editor.

1. Open Xbuilder and select ACTIONS>OPEN MERGE LIST.
2. Use the OPEN MERGE LIST FILE window to navigate to and open the Merge List file.

5 Approve or reject the new pages and/or scenes

When new pages are generated by the Merge List, they are added to the playlist as embedded 
pages until they have been “approved”. Approved pages become assets (shared pages) and 
they are saved in the specified default render path. Rejected pages remain in the playlist as 
embedded pages. 

When new scenes are generated by the Merge List, they are first placed in the specified 
temporary scenes category. Scenes are only moved to their specified render path location after 
they have been approved. Rejected scenes remain in the temporary scene folder. 

See page 3-8 for instructions on how to approve or reject new pages and scenes.
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Creating Merge List file in Microsoft Excel

The Merge List file can be in the form of a Microsoft Excel spreadsheet (.xls only), which 
contains specific column headers that allows Xbuilder to create new pages and/or scenes 
from existing assets (templates/scenes), apply specific attributes, and/or populate the 
asset’s fields.

Figure 3-3. Merge List spreadsheet

Figure 3-3 provides and example of a Merge List spreadsheet and demonstrates that the 
first row in the Merge List spreadsheet contains the mandatory column headers for the data 
the Xbuilder needs to create the new pages and/or scenes. 

The following list identifies and describes the columns and information are mandatory or 
commonly used in a Merge List spreadsheet: 

• PageName: The path and asset name of the template that the new page will be created 
from or the scene from which the new scene will be based.

• OutputName: The path and asset name given to the new page or scene. The 
outputName specified can be fully qualified. If it is not fully qualified the new page will 
be saved to a default path specified in the settings. If no default path is specified will 
then save to the asset root category. 

• RecallId: An alpha-numeric identifier given to the new page or scene. (Optional) 

• ExpiryDate: The date when the new page or scene is to be deleted from the repository. 
The format is yyyy-mm-dd. (Optional) 

• PublishLifespan: The number of days that must elapse since the last time the new 
page or scene has been accessed before it is removed from the published device. This 
does not remove it from the repository. (Optional) 

• RenderProfile: The name of the render profile to use when the user wants to render the 
page to file. The name of the render profile is defined inside of the render profile xml. 

• RenderPath: The folder where the user wishes the rendered file will be saved. 

6 With the new pages/scenes, you can perform the following tasks:

• Preview the new pages/scenes on a software CG (see page 3-11).

• Render all or an individual page/scene to a clip file (see page 4-1).

• Create and save a snapshot image of a new page or scene (see page 3-12).

• Perform edits to the content of new pages/scenes (see page 3-10).

Step Task Description
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• Duration: The duration of the page in dropframe timecode. This will be the duration of 
the file generated.

• <objectName>: Column 9 (I) and beyond are the name of a target control side object. 
The target object can be a text, textbox, image, clip, or cel animation object. 

The value for the image, clip, or cel animation override can be a fully qualified asset 
name. If the asset name is not fully qualified the asset will be searched for by the 
existing object's type. The asset from the first category in which it was found will be 
used. If the asset is not fully qualified and there is no existing object in the originating 
template then the asset cannot be found.

The object type is not defined in the object name to allow the reuse of the object names 
across types. This reduces the number of columns in the spreadsheet. 

Be mindful of the following conditions and behaviors when creating or using the Merge List 
spreadsheet file:

• Do not enter blank rows between the data as blank rows are interpreted as the end of file. 

• If the name and category specified for the new page or scene matches an existing 
page/scene and the Merge List is being processed, you will be prompted as to whether 
you want to replace it.

• If the specified recalI Id is already being used elsewhere, the new page or scene will 
steal the recalI Id. 

• The items specified in the Merge List will be converted into embedded pages in a playlist. 
Once approved, the embedded pages from the playlist will then be saved as shared pages.

Creating an XML Merge List file

The Merge List file can be in the form of a XML file, which contains specific attributes (tags) 
allowing Xbuilder to create new pages and/or scenes from existing assets (templates/scenes), 
apply specific attributes, and/or populate the asset’s fields.

The following example and the list below identifies and describes the attributes (XML tags) that 
are mandatory or commonly used in a Merge List to create new instance of pages and/or scenes:

<MergeList>

<Page name="Template/scene name" outputName="New page/scene name" 
recallId="recall ID" expiryDate="yyyy-mm-dd" publishLifespan="#days" 
renderProfile="renderProfile" renderPath="C:\folder" 
duration="#seconds">

<Textbox name="Textbox name">value</Textbox>

<Image name="Image name">value</Image>

<Clip name="Clip name">value</Clip>

<CelAnimation name="Cel name">value</CelAnimation>

</Page>

</MergeList>

NOTE

Each new instance of a page or scene must be specified within a separate Page name node.
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• Page name - The name of the template or scene to base the new page or scene on. 
The name must be fully qualified. 

• outputName - The name given to the new page or scene. The outputName specified can be 
fully qualified. If it is not fully qualified the new page will be saved to a default path specified in 
the settings. If no default path is specified will then save to the asset root category. 

• recallId - The recallId given to the new page or scene. This can be alpha-numeric. (Optional) 

• expiryDate - The date when the new page or scene is to be deleted from the repository. 
The format is yyyy-mm-dd. (Optional) 

• publishLifespan - The number of days that must elapse since the last time the new 
page or scene has been accessed before it is removed from the published device. This 
does not remove it from the repository. (Optional) 

• renderProfile - The name of the render profile to use when you want to render the page 
or scene to a file. The name of the render profile is defined inside of the render profile xml. 

• renderPath - The folder where you want the rendered file will be saved. 

• duration - The duration of the page or scene in dropframe timecode. This will be the 
duration of the file generated. 

• Textbox name - The name of the target textbox. Value is the text to be set on the textbox. 

• Image name - The name of the target image object. Value is the name of the image 
asset to set on the image object. 

• Clip name - The name of the target clip object. Value is the name of the clip asset to 
set on the clip object. 

• CelAnimation name - The name of the target cel animation object. Value is the name 
of the cel animation asset to set on the cel animation object. 

NOTE

The image, clip or celAnimation value specified can be a fully qualified name. If it is not fully 
qualified the image, clip, celAnimation from the first category in which it was found will be used. 
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Approving or rejecting new pages and scenes created from a 
Merge List

When new pages are generated by the Merge List, they exist only in the playlist as 
embedded pages, which means that the pages are not yet assets and that they only belong 
to that particular playlist. Therefore unless you save the playlist, you delete the new 
embedded pages. To conserve the pages for future use in other playlists, you can save 
them as shared page assets by using Xbuilder’s Approve feature.

Unlike pages, when new scenes are generated by the Merge List, they immediately become 
assets and are placed in the specified temporary scenes category. The scene assets 
remain in the temporary category until they are approved. Upon approval the scene assets 
are moved to the specified render path location.

To approve or reject new pages and scenes:

1. Verify that the default category settings in Xbuilder’s Merge List settings 
(TOOLS>SETTINGS>MERGE LIST) are properly configured (page 9-10). 

2. If not already done, open the Merge List in Xbuilder (page 3-13). The new pages and/or 
scenes will be generated and displayed in a playlist in Xbuilder’s Playlist Editor.

3. There are two (2) methods for approving new pages and/or scenes:

• Approved All - To quickly approve all of the items (pages & scenes) in the 
playlist, click the APPROVE ALL ITEMS IN MERGELIST button  in the Playlist 
Editor’s toolbar. Xbuilder runs through each item in the playlist, moves the 
assets to the appropriate categories, and changes the item’s status in the 
playlist to APPROVED.

• Approve individual - To approve new pages and/or scenes individually, 
select the item in the playlist. The selected page/scene opens in Xbuilder’s 
Template Editor. Click the APPROVE AND NEXT button  in the Template 
Editor’s toolbar to approve. Xbuilder then creates the shared page asset, 
moves the asset to the appropriate category, and changes the item’s status in 
the playlist to APPROVED. 

4. To reject the page/scene, click the REJECT AND NEXT button  in the Template 
Editor’s toolbar. When rejected, scene assets remain in the temporary category, while 
pages remain as embedded pages in the playlist. In both cases, Xbuilder changes the 
item in the playlist to red and its status to REJECTED. 
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Opening an existing page or scene
There are two (2) ways to open and display an individual page or scene in Xbuilder: 

• Navigating through the Asset Browser’s PAGES or SCENES root category and the 
page/scene assets are listed or previewed in the panel to the right of the Asset Browser. 
Double-click the asset’s name and the page/scene will open in the Template Editor.

Or,

• With a populated playlist open in the Playlist Editor, double-click a page or scene item 
in the playlist and it opens in the Template Editor. 

A page open in
the Template Editor
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Editing a page or scene’s content elements
When you open a standalone scene in Xbuilder’s Template Editor, you can make and save 
changes to the content of editable objects within the scene (i.e. change the image, edit the 
text, choose another cel animations...etc.), but you cannot reposition or make any other 
changes to the scene’s layout. 

Unlike scenes, when you open a page or template in Xbuilder, it is not the scene-side of the 
project that is displayed in the Template Editor, but rather the control-side (template). The 
control-side contains objects that are pre-programmed to control the content and behavior 
of the objects on the scene-side. Therefore, you can make certain modifications to the 
associated scene’s variable content fields before sending them to air, including:

• setting text in text boxes by clicking within the text box and typing in text.

• selecting a listed items from drop-down boxes 

• selecting check boxes to indicate a choice or enable a setting

• replacing existing images, cel animations, or clips with another of the same type

Replacing an image, cel animation, or clip on a page

The following instructions guide you through how to replace an image on a page/scene, 
however, the procedure is identical for replacing cel animations and clips.

To change an image:

1. Open the page so that it is displayed in Xbuilder’s Template Editor.

1. Right-click on the image. 

The SELECT AN IMAGE dialog box is displayed.

Figure 3-4. The Select an Image dialog box

The tree view at left lists all eligible categories from which a new image can be chosen. 
By default, the category containing the image is initially displayed. The selection of a 
new image may be restricted to a specific category. In this case the tree view shows 
the contents of this category instead of the IMAGES root category.
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2. Double-click the folder that contains the required image. Click the PROXY VIEW button 
 to display the folder’s contents as proxies, or click the LIST VIEW button  

display detailed asset information.

3. Double-click the desired image in the right window pane, or select the desired file and 
then click the SELECT button. The SELECT AN IMAGE dialog box closes and the new 
image appears in the page.

Previewing a page or scene on the Preview device
Since only a static version of the control-side of a template or page is displayed in Xbuilder’s 
Template Editor, it may not provide you with a true representation of how it will look when 
played out on a device. Similarly, standalone scenes open as static displays, meaning that 
you are not able to view the playout of any cel animations, clips or animated properties 
associated with the scene.

Xbuilder offers the PREVIEW PAGE/SCENE command  in the Template Editor’s toolbar as 
a method for viewing the playout of the template, page or scene that you currently have 
open in the Template Editor. The PREVIEW PAGE/SCENE renders and plays out the video, 
audio, and animation elements of the page/scene on the preview device (Software CG) 
specified in Xbuilder’s Manager. 

To preview a template, page, or scene on a connected device:

1. Set up the preview device.

In most cases, the device used for previewing the playout will be a Vertigo Software CG. 
Therefore, you should verify that the software CG is specified in the SWCG EXECUTABLE 
LOCATION parameter on Xbuilder’s GENERAL setting page (page 2-7) and that the device 
is also properly configured as the Preview device in Xbuilder’s Device Manager (see 
“Adding and configuring a Preview device” on page 2-7). 

2. Open the desired template, page, or scene so that it is displayed in Xbuilder’s Template Editor.

3. Select the PREVIEW PAGE/SCENE command  from the Template Editor’s toolbar.

A publishing status bar briefly appears in the right-corner of the Template Editor’s toolbar. 
Once the publishing is complete, the scene automatically begins to play in the 
software CG’s playout window.

Template in the Template Editor Preview of the page using the Software CG
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Saving a snapshot (image file) of a page or scene’s 
playout

The TAKE SNAPSHOT OF PAGE/SCENE command  in the Template Editor’s toolbar allows 
you to render and save (as an image file) a single frame of the scene’s playout. This is 
particularly useful when the template, page or scene contains clips and/or cel animations, 
as you can specify the exact frame during playout to capture. The resulting image file can 
then be easily distributed (i.e. by email or file transfer) for feedback and/or approval.

To render and save a snapshot of a template, page or scene’s playout:

1. Verify that Xbuilder is properly configured/connected to a preview device (Software CG) 
in the Device Manager (page 2-7) and that the software CG is specified in the SWCG 
EXECUTABLE LOCATION parameter on Xbuilder’s GENERAL settings page (page 2-7).

2. Verify, or edit, the RENDER PATH location where the image file will be saved to by opening the 
Software CG’s Dashboard application and selecting the ADVANCED>GENERAL page (figure 3-5).

Figure 3-5. The Render Paths settings determine the storage location of the frame’s snapshot

3. Open the desired template, page or scene asset so that it is displayed in Xbuilder’s 
Template Editor.

4. Select the TAKE SNAPSHOT OF PAGE/SCENE command  from the Template Editor’s toolbar.

The TAKE SNAPSHOT dialog box appears (figure 3-6).

Figure 3-6. The Take Snapshot dialog box
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5. Type a name for the rendered image file in the TARGET FILENAME field.

NOTE

The rendered image format of a snapshot is always Targa (.tga). As such, the Render Format 
property in the Take Snapshot dialog box cannot be changed.

6. Verify the START OFFSET value, which determines the specific frame of the playout that 
will be extracted.

NOTE

Since the duration of a snapshot is always one frame, the Duration property in the Take 
Snapshot dialog box cannot be changed. Similarly, the Quality level property is fixed at 
HIGH and cannot be changed.

7. Click the RENDER button and a publishing status bar appears in the right-corner of the 
Template Editor’s toolbar. Once the publishing is complete, the scene appears on the 
preview device and the frame is automatically converted to an image and saved to an 
image file in the specified render folder.

8. Navigate to the directory where the image was saved (RENDER PATH setting from 
step 3). Open the saved file and the image will display in your targa (.tga) compatible 
media viewer.
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CLIP FILE

Xbuilder’s RENDER TO FILE feature allows you to render and save the playout of templates, 
pages and scenes as a video clip files. This is particularly useful when a template, page or 
scene contains clips and/or cel animations, since the resulting clip file captures and saves 
the full video, audio and animation elements of the scene’s playout.

There are three (3) workflows in which Xbuilder’s Render to File feature is intended to be 
used:

• “Render to VAF for pre-rendered playout” on page 4-2

• “Render to MXF for playout on a video server” on page 4-3

• “Render to MPEG for preview” on page 4-4

Regardless of which workflow you choose, Xbuilder provides the following two (2) methods 
for rendering pages and/or scenes to a clip file:

• “Manual rendering pages and/or scenes to a file” on page 4-5

Uses the Template Editor’s RENDER PAGE/SCENE TO FILE button  to render and 
save the playout of an individual scene to a clip file.

• “Batch-rendering of pages and/or scenes to a file” on page 4-7

When a Merge List is used to create pages and scenes, all of the resulting pages and 
scenes can be rendered and saved as individual video clip files using the Playlist 
Editor’s RENDER ALL ITEMS IN PLAYLIST button .
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Render to VAF for pre-rendered playout

Xbuilder’s Render to File feature uses the Vertigo Software CG’s rendering engine to render 
pages and scenes into .vaf (Vertigo Animation Format) files. The rendered VAFs can then 
be easily ingested (as-is) into the Xmedia Server by setting up a watch-folder using the 
Vertigo File Ingest Service for playout on Vertigo XG devices.

The advantage of pre-rendering pages and/or scenes to VAF is that it minimizes risk during 
the playout by eliminating live rendering and data insertion. 

Figure 4-1 demonstrates the Render to file (VAF) workflow in which master templates are 
first created in Xstudio. Once the templates are opened in Xbuilder, pages are created by 
populating the templates with instance data (either individually or as a batch using a Merge 
List). When Render to File is executed, the new pages are rendered and saved to disk (not 
the Xmedia Server) as VAF clip files. You can then import the files into the Xmedia Server 
and the VAFs can be played out on Vertigo XG devices.

Figure 4-1. Render to file (VAF) workflow

NOTES

• Rendering VAF files requires the XG ENCODE license.

• VAF is a heavily compressed format and encoding times can be very long.
The encoder is multi-threaded and will scale to the number of available cores.

• VAF looping points cannot be set in this workflow.

• VAF clips will automatically be cropped based on the scene’s content.
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Render to MXF for playout on a video server

Xbuilder’s Render to File feature uses the Vertigo Software CG’s rendering engine to render 
pages and scenes into XDCAM and IMX compatible MXF files that are natively supported 
on virtually all modern playout servers. 

When you configure the Render to File feature, you select the output format from among 
the following render format profiles:

• MXF IMX 25 (PCM audio)

• MXF IMX 30 (PCM audio)

• MXF IMX 40 (PCM audio)

• MXF IMX 50 (PCM audio)

• MXF MPEG2 (PCM audio) HD

• MXF MPEG2 (PCM audio) SD

• MXF XDCAM HD-50 (50 Mbit 4:2:2) (PCM)

Figure 4-2 demonstrates the Render to file (MXF) workflow in which master templates are first 
created in Xstudio. Once the templates are opened in Xbuilder, pages are created by 
populating the templates with instance data (either individually or as a batch using a Merge 
List). When Render to File is executed, the new pages are rendered and saved to disk (not 
the Xmedia Server) as MXF clip files. The MXF files are now ready for eventual playout on a 
3rd party video server.

Figure 4-2. Render to file (MXF) workflow

NOTES

• Supplied profiles are heavily tuned and are not intended to be modified by the end-user.

• Render to playout server compatible formats requires the XGENCODEFORPLAYOUT 
software license. However, MPEG2 encoding only requires the XG ENCODE license.

• Encoding scales to the number of CPU cores on the system running Xbuilder.

• MXF files generated by Xbuilder are not intended to be re-ingested into the Xmedia Server.

• MXF Op1a has been deprecated on Windows 7.
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Render to MPEG for preview

Xbuilder’s Render to File feature uses the Vertigo Software CG’s rendering engine to render 
pages and scenes into MPEG clip files that can be saved to disk and then viewed on most 
media players.

Rendering pages and scenes to MPEG is mainly used in situations where you want to share 
and allow others to preview the file’s playout using a portable and common playout format.

The Render to file (MPEG) workflow starts with the creation of master templates in Xstudio. 
Once the templates are opened in Xbuilder, pages are created by populating the templates 
with instance data (either individually or as a batch using a Merge List). When Render to 
File is executed, the new pages are rendered and saved to disk (not the Xmedia Server) as 
MPEG clip files. The MPEG files can then be ingested into the Xmedia Server or distributed 
for previewing and/or approval.
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Manual rendering pages and/or scenes to a file
When an individual template, page, or scene is open in Xbuilder’s Template Editor, you can 
use the RENDER PAGE/SCENE TO FILE button  in the Template Editor’s toolbar to capture 
and save the asset’s playout to a video clip file.

To render and save a template or page as a video file:

1. Verify that Xbuilder is properly configured/connected to a preview device (i.e. Software CG) 
in the Device Manager (page 2-7).

2. Open the Xbuilder Settings window (Tools>Settings) and configure the SWCG 
EXECUTABLE LOCATION parameter on the GENERAL settings page (page 2-7).

3. Select RENDER TO FILE in the Settings window and configure the default settings (page 9-12).

4. Open the template, page or scene so that it is displayed in Xbuilder’s Template Editor.

5. Select the RENDER PAGE/SCENE TO FILE button  from the Template Editor’s toolbar.

The RENDER TO FILE dialog box appears (figure 4-3).

Figure 4-3. The Render to File dialog box

6. Type a name for the rendered file in the TARGET FILENAME field.

7. Select the desired video format for the rendered file from RENDER FORMAT drop-down list. 

NOTE

If you load an HD scene and specified an SD profile (or vice versa), the render fails. The 
profile must be consistent with the format of the scene.
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8. You can edit the DURATION value, if you want it to be different from the value specified 
in the Default Duration field in the Render To File settings (step 3).

9. Press the RENDER button and a publishing status bar appears in the right-corner of the 
Template Editor’s toolbar. Once the publishing is complete, the captured video 
automatically starts to playout on the preview device and the video file is saved to the 
default render path folder.

NOTE

The rendered video file is saved to the specified location on your system and it is not saved 
as a Clip asset on the Xmedia Server. If at anytime you want to use the render clip file as 
an asset within the Vertigo Suite, you must use Xstudio or Xplorer to import/ingest the video 
file into the Xmedia Server.
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Batch-rendering of pages and/or scenes to a file 
When a Merge List is used to create pages and scenes (see page 3-13), all of the resulting 
pages and scenes can be rendered and saved as individual video clip files using the Playlist 
Editor’s RENDER ALL ITEMS IN PLAYLIST button .

To render and save all of the resulting items from a Merge List:

1. Verify that Xbuilder is properly configured/connected to a preview device (i.e. Software CG) 
in the Device Manager (page 2-7).

2. Open the Xbuilder Settings window (Tools>Settings) and configure the SWCG 
EXECUTABLE LOCATION parameter on the GENERAL settings page (page 2-7).

3. Select RENDER TO FILE in the Settings window and configure the default settings (page 9-12).

Although the settings associated with each item in Merge List file take precedent, 
configuring these settings is prudent in case the Render Profile and Duration 
attributes are not specified in the Merge List file.

NOTE

The DEFAULT PROFILE PATH and DEFAULT PROFILE settings only need to be set when using 
Xbuilder on Windows7.

4. Create the Merge List file and load it into Xbuilder using the procedure described on 
page 3-13.

5. Once the new pages and/or scenes from the Merge List have been created and are 
displayed in the playlist, select the RENDER ALL ITEMS IN PLAYLIST button  from the 
Playlist Editor’s toolbar.

Xbuilder automatically launches the preview device and starts to publish and render 
each of the pages and scenes from the playlist. Once an item is published, the page or 
scene’s playout in previewed on the device’s display.

NOTE

The profile specified must be consistent with the format of the scene. The render will fail if 
they are different.

6. Once the process is complete, you can navigate to the directory where the clip file was 
saved and open the saved file in an appropriate media viewer.

NOTE

The rendered video file is saved to the specified location on your system and it is not saved 
as a Clip asset on the Xmedia Server. If at anytime you want to use the render clip file as 
an asset within the Vertigo Suite, you must use Xstudio or Xplorer to import/ingest the video 
file into the Xmedia Server.
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5 PERFORMING QUALITY CONTROL (QC) 
AND MEDIA CHECK (MC)

The Vertigo Quality Control (QC) workflow is the process by which graphics can be 
previewed and validated before they are published to the target devices and taken to air 
(figure 5-1). The QC workflow creates the graphics files from Adobe After Effects Project 
compositions and a Make List spreadsheet (1). The resulting graphics are then brought into 
Xbuilder as a playlist where they can be previewed on the Software CG and validated 
(approved/rejected) individually (2). The status of each asset is updated in the Make List 
and the approved graphics are moved to the Approved Category folder on the XMS, which 
can be set up to automatically publish to the playout device(s).

Once the graphics are approved and published to the device(s), you can use the Vertigo 
Media Check (MC) workflow to quickly preview and verify that all of the approved graphics 
have actually been published to the correct devices (3). Opening an Air List in Xbuilder 
generates a playlist of approved graphics. The Air List is usually the same spreadsheet as 
the Make List, but the status of all of the assets are Approved. You can preview the graphics 
and/or launch a verification in which Xbuilder verifies the actual availability of the graphics 
assets on the targeted device’s database. The asset’s status is then reported back and 
displayed in the playlist.

By using the QC and MC workflows, you can be confident that your graphics are correct 
and that they are ready to go to air. 

Figure 5-1. The Vertigo QC & MC Workflow block diagram
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The following sections provide instructions and details regarding the configuration and use 
of the Vertigo QC and MC workflows:

• “Setting up the QC and MC workflows” on page 5-3

• “Creating a Make List / Air List spreadsheet” on page 5-9

• “Using AE Plug-in and the Make List to create and ingest graphics” on page 5-11

• “Quality Control: Previewing and validating graphics in Xbuilder” on page 5-12

• “Media Check: Graphics publish verification” on page 5-14
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Setting up the QC and MC workflows
Prior to using the Vertigo QC and MC workflows, some of the Vertigo Suite components 
(i.e. destination folders, Xbuilder, device manager, licensing) must be configured to ensure 
the proper coordination of resources.

The following sections provide instructions for configuring the Vertigo Suite for the QC and 
MC workflows:

1. “Create and set up the Subfolders and Approved Category folders” on page 5-3

2. “Specify Xbuilder’s settings for the QC and MC workflows” on page 5-4

3. “Associate channels to devices in Xbuilder’s Device Manager” on page 5-5

4. “Verify that the system templates are installed and publish them to the SWCG” on page 5-6

5. “Verify the presence of the QC license” on page 5-8

Create and set up the Subfolders and Approved Category folders

We recommend that you create the Subfolders and Approved Category folders in advance 
of using the QC workflow’s Make List. The Make List’s SUBFOLDERS column specifies into 
which subcategory folders on the central Xmedia Server, new assets will be ingested to. 
Meanwhile, the APPROVED CATEGORY column identifies the folder into which the assets will 
be moved once they have been approved. See page 5-9 for more information about 
creating and using the Make List file.

A compelling reason to set up the Approved Category folders in advance is that it allows 
you to assign publish rules to these folders. That way, when the assets are moved from the 
subfolders upon approval, the assets will automatically be published to the appropriate 
playout device(s).

NOTE

If you choose not to pre-configure the Approved Category folder for auto-publish, you will 
have to manually publish the assets before being able to preview them on a device or before 
using the MC workflow.

To create and set up the Subfolders and Approved Category folders:

1. Open Xplorer.

2. Create a new subfolder within the Clips and/or CelAnimations root categories for the 
ingested asset files.
a. Right-click on the Clips root category and select the NEW CATEGORY command.
b. Specify a name for the subfolder in the NEW CATEGORY dialog box and click OK.
c. Repeat steps a and b for the CelAnimations root category.

3. Create a new folder within the Clips and/or CelAnimations root categories for the 
Approved Category.
a. Right-click on the Clips root category and select the NEW CATEGORY command.
b. Specify a name for the Approved subfolder in the NEW CATEGORY dialog box and 

click OK.
c. Repeat steps a and b for the CelAnimations root category.
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4. Assign publish devices to the Approved Category folders.
a. Right-click on the new Approved Category folder in the Clips root category and 

select the PROPERTIES command.
The PUBLISH DEVICES dialog box appears.

b. Select the device(s) that you want the assets to be automatically published to and 
then click OK.

c. Repeat steps a and b for the Approved Category folder in the CelAnimations root 
category.

Specify Xbuilder’s settings for the QC and MC workflows

To accommodate the QC and MC workflows, a few of Xbuilder’s settings must be configured. 

To configure Xbuilder’s settings for the QC workflow:

1. Launch Xbuilder.

2. In the DEVICE FOR VERIFY drop-down list, select USE PLAYLIST DEVICES (figure 5-2).

Figure 5-2. Set Xbuilder’s Device for Verify parameter to “Use Playlist Devices”

3. Open Xbuilder's SETTINGS dialog box (TOOLS>SETTINGS).

Figure 5-3. Xbuilder’s Settings

4. Set the XBUILDER>GENERAL>VERIFY PLAYLIST parameter to MANUAL.

5. Set the XBUILDER>GENERAL>NUMBER OF VERIFY DEVICES to the number of devices that 
you expect to use for verifying assets.

6. Click OK in the SETTINGS dialog box to apply the new settings and close the dialog box.
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Associate channels to devices in Xbuilder’s Device Manager

Xbuilder’s Device Manager associates device channel names to actual physical devices 
(figure 5-4). Xbuilder uses this association when previewing and performing media check 
of the asset on a device. 

When performing quality control tasks (validation), only the PREVIEW device is required to 
be assigned to the local software CG in the Device Manager. However, when performing 
media checks, the number of devices that can be associated is the Preview device plus the 
number of devices identified in the NUMBER OF VERIFY DEVICES setting. 

The channel names in the Device Manager’s NAME column (figure 5-4) are what you will 
enter in the Make List / Air List file’s TARGET CHANNEL column (see page 5-9). When 
Xbuilder performs a media check, it uses the data (channel names) in the TARGET CHANNEL 
column to determine on which devices to look for published assets.

Figure 5-4. Associate device channels with playout devices in the Device Manager

To configure Xbuilder’s Device Manager for QC and MC tasks:

1. Open Xbuilder’s Device Manager (TOOLS>DEVICE MANAGER).

2. Set the PREVIEW device to the local Software CG defined.

3. Change the default channel names that appear in the NAME column by clicking in the 
cell and typing a new name (figure 5-5).

Figure 5-5. Specify new channel names which will be used in the Make List file’s TARGET CHANNEL column

4. Using the DEVICE LIST and the ADD TO ACTIVE DEVICES button  associate each one 
of the channels to their respective devices.

Note that the channel names are used by the playlist to identify the target device(s) for 
each asset.

5. Click CLOSE in the DEVICE CONFIGURATION dialog box to apply the changes and close 
the dialog box.
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Verify that the system templates are installed and publish them to the SWCG

The QC and MC workflows require that a series of system templates be installed on the 
central Xmedia Server and published to all Vertigo preview and playout devices, including 
the Software CG. The system templates are general purpose "asset holders" for different 
asset types and different TV formats. 

Generally, the system templates are automatically added when the Vertigo Suite 
software is installed on the Xmedia Server and Vertigo hardware devices. Since the 
system templates are vital to the proper functioning of the QC and MC workflows, we 
recommend that you verify that all of the system templates are installed on the Xmedia 
Server and Vertigo playout devices using Xplorer.

The Vertigo Software CG is used by the QC and MC workflows as the preview device. 
Unlike the hardware playout devices, the system templates are not published to the 
Software CG during the Vertigo Suite installation. Therefore, you must publish the 
system templates to the Software CG device as part of the QC workflow configuration.

To verify that the system templates are installed on the central XMS and hardware 
playout devices:

1. Open an instance of Xplorer, which is connected to the central Xmedia Server.

2. Select the Xmedia Server in the Device Viewer.

3. In the Asset Browser, select TEMPLATES>SYSTEM TEMPLATES and verify that all of the 
system templates are displayed in the Asset Gallery (figure 5-6).

If the system templates are not present, or if some are missing, please import the 
templates from the following directory location: C:\Program 
Files\VertigoXmedia\Apps\Support\SystemTemplates.rar. Decompress the 
files to a local directory and import them to the Xmedia Server using Xplorer. If the 
templates still do not appear, please contact our Technical Support Services.

Figure 5-6. System Templates on the central Xmedia Server
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4. For each of the hardware playout devices, select the hardware device and then select 
TEMPLATES>SYSTEM TEMPLATES in the Asset Browser. Verify that all of the system 
templates are displayed in the Asset Gallery.

If the system templates are not present, or if some are missing, please import the 
templates from the directory location identified in step 3 or publish the templates from 
the Xmedia Server to the device.

To publish the system templates to the Software CG preview device:

1. Open an instance of Xplorer, which is connected to the central Xmedia Server.

2. Select the Xmedia Server in the Device Viewer.

3. In the Asset Browser, select TEMPLATES>SYSTEM TEMPLATES.

4. Right-click on the System Templates subcategory in the Asset Browser and select the 
PUBLISH TO>CG menu command (figure 5-7). The Publish Progress window appears 
as the assets are published to the Software CG device.

Figure 5-7. Publishing the system templates to the Software CG device

5. Once the publishing is complete, close the Publish Progress window.

6. Select the Software CG device in Xplorer’s Device Viewer.

7. In the Asset Browser, select TEMPLATES>SYSTEM TEMPLATES and verify that all of the 
system templates are displayed in the Asset Gallery.

If the system templates are not present on the Software CG device, or if some are 
missing, please contact our Technical Support Services for assistance.
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Verify the presence of the QC license

The QC and MC workflows requires that a valid QC license be installed and validated on 
the central Xmedia Server. Without a valid QC license, Xbuilder’s Open MakeList and 
Open AirList menu commands are disabled.

To verify that a valid QC license is installed and validated on the Xmedia Sever:

1. Open Xbuilder.

2. Select the Actions menu.

If the Open MakeList and Open AirList menu commands are enabled, then the QC 
license is properly installed and validated on the Xmedia Server.

If the Open MakeList and Open AirList menu commands are disabled:

a. Open the License Manager (HELP>LICENSE). 

b. Click the SHOW DETAILS button in the License Manager dialog box.

c. Select the LICENSED APPLICATIONS AND DEVICES tab.

d. Verify the QC license is present in the list. If not, please contact our Technical 
Support team to obtain a valid QC license. If the license is present, please verify 
that the Xmedia Server and its services are properly running.
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Creating a Make List / Air List spreadsheet
Both the QC and MC workflows require you to create a specially formatted Excel 
spreadsheet called a Make List (for QC) or Air List (for MC). The same spreadsheet can be 
used for both QC and MC tasks since it contains the same mandatory data for creating and 
organizing the graphics assets. The main difference between the two files is that the MC 
workflow requires that all of the assets in the Air List’s have the STATUS column marked as 
APPROVED.

The Make List is an Excel Spreadsheet (.xls) whose data is used by the Vertigo After Effects 
Plug-in to create graphics assets (clips or cel animations) based on an After Effects project. 
The resulting asset are then stored automatically on the Xmedia Server. The same Make 
List is then used to create a playlist in Xbuilder, which is used during the quality control 
(preview and validation) and the media check tasks.

NOTE

To ensure that the Make List contains all of the required columns, a sample Make List is 
available to be used as a template: 
http://support.miranda.com/portal/software/Vertigo%20Software/Makelist_sample.xls

Figure 5-8. Make List spreadsheet

Figure 5-8 demonstrates that the first row in the Make List contains the mandatory column 
headers for the data that the After Effects Plug-in and Xbuilder need to create the assets 
and playlist. The following list describes the columns and information that must be present 
in the Make List spreadsheet:

• PROJECT NAME: The path and filename of the After Effects project. This information is 
used by the After Effects plug-in to generate the asset. This information is not used by 
Xbuilder.

• OUTPUT FILE NAME: The name of the asset that is generated by the After Effects plug-
in. The name must include the extension, so that Xbuilder can tell what the asset type 
is (i.e. Clip versus Cel animation) even though the extension does not appear in the 
asset name in Xmedia Server.
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• FORMAT: The format of the asset, which is used by Xbuilder to launch the software CG 
in the appropriate format to get the best preview possible. Acceptable values are:
• NTSC
• PAL
• HDTV_720_60
• HDTV_720_60M
• HDTV_720_50
• HDTV_1080_30
• HDTV_1080_30M
• HDTV_1080_25
• NTSC_16_9
• PAL_16_9

• STATUS: The status of the asset (Approved, Rejected). The After Effects plug-in only 
generate assets for those not marked as APPROVED. Xbuilder writes the status into the 
Make List that was opened.

• APPROVED CATEGORY: The category folder into which the assets are moved when they 
have been approved. The category should be read as Subfolder 1\Subfolder 
2...\Subfolder N. We recommend that you create the Approved Category folder in 
advance so that you can assign publish rules to this folder. That way, when the assets 
are moved into this folders, they will also be automatically published to the appropriate 
playout devices. See page 5-3 for instructions. 

• SUBFOLDER 1, ..., SUBFOLDER N: The category folder into which the After Effects plug-
in puts the asset when it is generated. This is the category folder where unapproved 
assets exist and rejected assets are moved to (from the approved category). We 
recommend that you create these folders in advance. See page 5-3 for instructions.

• TARGET CHANNEL: A comma-delimited list of names of devices to which the asset is 
published. The devices specified must be the names of the target device channels, 
which are defined in the NAME column in Xbuilder’s Device Manager (see page 5-5). 
When Xbuilder generates the playlist, one playlist element will be created for each of 
the asset’s targeted device channels (figure 5-9).

Figure 5-9. Multiple target channels results in one playlist element for each of the asset’s targeted devices

Make List / Air List

Playlist

Device Manager
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Using AE Plug-in and the Make List to create and ingest 
graphics

The QC workflow uses the Vertigo After Effects Plug-in’s MERGE MODE to create and ingest the 
graphics files (clips and/or cel animations) into the Xmedia Server. Using the Make List 
spreadsheet as an input, Merge Mode creates the graphics files from the specified Adobe After 
Effects Project composition(s) and then ingests them to the destination categories on the XMS. 

To use the After Effects Plug-in and Make List to create and ingest graphics files:

1. Launch Adobe After Effects and select the FILE>EXPORT>MIRANDA ANIMATION (MERGE 
MODE) menu command.

A message appears warning you that the project you currently have open will be closed 
without saving. To continue, simply click OK. 

The EXPORT MIRANDA ANIMATION dialog box appears (figure 5-10).

Figure 5-10. The Export Miranda Animation dialog box 

2. Click the  button in the INPUT - DATA SOURCE FILE NAME field to navigate to and select 
the Make List spreadsheet (see page 5-9).

3. In the Output destination section, enable EXPORT TO XMS SERVER NAME / IP and then 
type either the Xmedia Server’s hostname or the IP address of the XMS device where 
the output files will be ingested to.

4. Enable OVERWRITE EXISTING FILES / ASSETS if you wish to automatically replace an existing 
file that may already exist using the exact same name in the exact same location.

5. Select the OPTIONS button to expose advanced options, which specify how the 
graphics files will be created, including specifying the looping behavior. See the “AFTER 
EFFECTS PLUG-IN USER MANUAL” for more information.

6. Create the graphics files by clicking OK. 

The EXPORT MIRANDA ANIMATION dialog box closes and the EXPORT PROGRESS dialog 
box appears to track the graphics files’ creation.

7. Verify that the files were ingested into the Xmedia Server by opening Xbuilder and navigate 
through the Asset Browser to the expected destination category and subfolder.

NOTE

If the subfolders were not previously set to automatically publish the assets to the target 
devices (see page 5-3), you must open Xplorer and manually publish the assets to the 
preview and verify devices before proceeding.
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Quality Control: Previewing and validating graphics in 
Xbuilder

The QC workflow allows you to preview and validate (approve or reject) the graphics that 
the After Effects Plug-in and the Make List file created and ingested into the Xmedia Server.

When you open the Make List file in Xbuilder, a playlist is created that contains an element 
for each of the assets (pages) that were created by the After Effects Plug-in’s export. 
Selecting an element in the playlist, opens the page in Xbuilder’s Template Editor. 

To preview the page’s playout, select the PREVIEW PAGE button and the page plays out in 
the local Software CG’s Live window. To validate the page, simply select either the APPROVE 
or REJECT buttons. Approved assets are automatically moved to the Approved Category 
that was specified in the Make List spreadsheet, while rejected assets are flagged as such 
for further revising.

To use Xbuilder to preview and validate graphics created by using a Make List:

1. Launch Xbuilder and select ACTIONS>OPEN MAKELIST... menu command.

The OPEN MERGE LIST FILE dialog box appears.

NOTE

The Open MakeList command is only enabled if a valid QC license is found on the Xmedia 
Server. Please contact our Technical Support team to obtain a valid QC license.

2. Select and open the Make List file.

Xbuilder creates a temporary playlist with one element per asset (figure 5-11). The first 
element is selected by default and is displayed in Xbuilder’s Template Editor pane. If 
an asset has multiple target devices, it will appear multiple times in the playlist with 
different target devices (see page 5-10).

If there is any issue parsing the data or finding the asset, a comment is inserted in the playlist. 

3. To preview the page (element) selected in the playlist, simply click the PREVIEW PAGE 
button  in Xbuilder’s Template Editor toolbar.

The page is automatically published and opened in the local Software CG’s Live 
window. The Live Window displays the page’s playout in the format associated with the 
page’s template (figure 5-11). You can preview the page multiple times.

Figure 5-11. Pages from the Make List’s playlist can be previewed in the local Software CG
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NOTE

When previewing a page, the Software CG and its Live window open automatically in the 
format associated with the page’s template. Each time you preview another page whose 
format is different from the current page, the Live Window closes and reopens in the 
appropriate new format. Also note that since these instances of the Software CG are 
launched by Xbuilder, the Software CG also closes when Xbuilder is closed.

4. To validate pages, Xbuilder offers three (3) buttons in the Template Editor’s toolbar. 

5. After validating the pages, you can close the playlist and/or Xbuilder. Before closing, 
you are prompted to save the playlist. You can select NO, since the playlist is meant to 
be temporary and each element’s status has already been saved to the Make List file.

If you need to revisit the playlist in the future, you simply have to open the Make List in 
Xbuilder as was described in step 1.

APPROVE

Select the Approve button if you are satisfied with the page’s playout 
and it is deemed ready to go to air “as-is”. Once Approved, the asset is 
moved to the Approved Category that was specified in the Make List 
spreadsheet. The element’s status is updated to Approved in the 
playlist and the status is written to the opened Make List spreadsheet. 
The next item in the playlist is then selected and opened automatically.

Note that approved assets may still be previewed and rejected by 
reselecting the element in the playlist.

REJECT

Select the Reject button if you are not satisfied with the page’s playout 
and you would like it to be flagged for revision.

Once rejected, the asset is moved back to the original category. The 
element’s status is updated to Rejected in the playlist and the status is 
written to the opened Make List spreadsheet. The next item in the 
playlist is then selected and opened automatically.

Note that rejected assets may still be previewed and approved by 
reselecting the element in the playlist.

SKIP

Select the Skip button to move down the playlist to the next element. 
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Media Check: Graphics publish verification
The Vertigo Media Check (MC) workflow allows Master Control to quickly verify that all of 
the assets that were validated (approved) during the QC workflow have been published to 
the target playout devices.

A prerequisite for the MC workflow is the QC workflow’s Make List with the Status all of the 
assets marked as ACCEPTED. The Make List also must contain a column called TARGET 
CHANNEL, which lists the devices on which to verify the publish (see page 5-10). 

When used for MC workflow purposes, the Make List file is referred to as an AIR LIST. 
The Air List file is imported into Xbuilder, which creates a temporary playlist that contains an 
element for each of the assets (pages). If an asset has multiple target devices, the asset will 
appear multiple times in the playlist with different target channels (see page 5-10).

You can preview any of the assets on the Software CG selecting the page (element) in the 
playlist and clicking the PREVIEW PAGE button  in Xbuilder’s Template Editor toolbar.

A media check is executed by clicking the VERIFY PLAYLIST button . The availability of 
the asset is verified directly in the target device’s database. A comparison is also performed 
between the published graphic file on the device and the graphic file in the central Xmedia 
Server. The results of the verification and comparison are displayed in the item’s Status in 
the playlist. Possible status messages are: 

• Ready - The asset is published and ready to be used.

• Cannot Connect to Device - Xbuilder is unable to connect to the target device’s 
database. Either the device is offline or not properly defined in the Device Manager.

• Asset on Device but Not Published - The asset exists as an asset on the device’s 
database, but is not found in the publish folder. This occurs if someone deletes the 
published file without deleting the asset from the device’s database.

• Asset Not Published Or Is Not Same Version - The asset does not appear to be in 
the device’s database. You will also get this message if an asset of the same name 
exists on the device, but is not the same as the one on the central Xmedia Server. 

• Unknown Device - The asset is targeting a device that is not defined in the Device 
Manager.

To use Xbuilder and an Air List to verify that the assets have been published to the 
target playout devices:

1. Launch Xbuilder and select ACTIONS>OPEN AIRLIST... menu command.

The OPEN AIR LIST FILE dialog box appears.

NOTE

The Open AirList command is only enabled if a valid QC license is found on the Xmedia 
Server. Please contact our Technical Support team to obtain a valid QC license.

2. Select and open the Air List file.

If there is any issue parsing the data or finding the asset, a comment is inserted in the 
playlist. 



Xbuilder User Manual 5-15

Performing Quality Control (QC) and Media Check (MC) 

3. To preview the page (element) selected in the playlist, simply click the PREVIEW PAGE 
button  in Xbuilder’s Template Editor toolbar.

The page is automatically published and opened in the local Software CG’s Live window. 

NOTE

When previewing a page, the Software CG and its Live window open automatically in the 
format associated with the page’s template. Each time you preview another page whose 
format is different from the current page, the Live Window closes and reopens in the 
appropriate new format. Also note that since these instances of the Software CG are 
launched by Xbuilder, the Software CG also closes when Xbuilder is closed.

4. To verify that the assets in the playlist have been successfully published to the target 
device(s), simply click the VERIFY PLAYLIST button . 

Xbuilder reports results of the media check query in the playlist’s STATUS column. 
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Xbuilder allows you to build manual or automatic playlists, which are ordered sequences of 
program clips and branding and promotional graphics elements (i.e. pages or scenes). 
Manual playlists are typically designed to be played back sequentially by operator control 
using Xplay, while automatic playlists are typically designed to have specific time and 
duration values that are used during playback by Xplay. 

The following sections provide instructions for how to create and edit playlists in Xbuilder:

• “An overview of the Playlist Editor” on page 6-2

• “Procedural overview for creating a sequential playlist” on page 6-3

• “Creating a new playlist” on page 6-4

• “Opening an existing playlist” on page 6-4

• “Populating a playlist” on page 6-6

• “Appending or inserting the contents of a playlist to a playlist” on page 6-9

• “Configuring the Playlist table columns” on page 6-11

• “Repositioning playlist items within the playlist” on page 6-17

• “Adding segments to the playlist” on page 6-19

• “Adding comments to the playlist” on page 6-21

• “Deleting playlist items from the playlist” on page 6-22

• “Editing the properties associated to the playlist items” on page 6-24

• “Saving a playlist” on page 6-26

• “Reloading the playlist” on page 6-28



6-2 Xbuilder User Manual

Creating and using playlists 

An overview of the Playlist Editor
The Playlist Editor allows you to build sequential lists of graphic pages, scenes and clips. 
The contents and positioning of the elements in the playlist determine the playout order and 
duration of the playlist. 

Figure 6-1 and the following descriptions provide an overview of the Playlist Editors’ 
features and components. 

Figure 6-1. Playlist Editor components

1. TOOLBAR: A series of buttons that allows you to perform actions related to creating, 
opening, saving, and populating playlists. See “Playlist Editor’s toolbar” on page 8-9 for a 
description of each button on the toolbar.

2. NAME: Displays the name of the playlist that is currently displayed in the Playlist Editor. An 
asterisk appears beside the name until the playlist, or edits to the playlist, have been saved.

3. DEVICE FOR VERIFY: Allows you to target a specific device or all of the configured 
devices when a playlist verification is executed. See “Configuring a device for the 
verification of playlist elements” on page 2-9 and “Opening an existing playlist” on page 
6-4 for more details.

4. PLAYLIST: The Playlist is the area where you create a sequential playlist by adding and 
organizing pages, scenes and clips into the intended playout order. Generally, each row in 
the playlist represents a page, scene or clip to be played out. To help further organize 
playlists, rows of pages, scene and clips can be gathered into playlist segments and 
comment rows can also be added. 

The playlist’s columns display information about each page included in the playlist. You 
can determine which columns are displayed or hidden in the playlist table by using the 
COLUMN LAYOUT dialog box. You can also determine the order in which the columns 
appear in the table. See “Configuring the Playlist table columns” on page 6-11 for 
descriptions of each column and instructions for how to display or hide certain Playlist 
table columns.

1

2

4

3
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Procedural overview for creating a sequential playlist
The procedure below identifies the high-level steps involved in creating playlists for playing 
out branding and promotional graphics sequences. Subsequent sections (identified by the 
links within the procedure) provide step-by-step instructions for performing each step. 

To create a sequential playlist in Xbuilder:

1. Create a new playlist, or open an existing playlist.

• “Creating a new playlist” on page 6-4

• “Opening an existing playlist” on page 6-4

• “Verifying the contents of a playlist” on page 6-5

2. Populate the playlist with pages, scenes, clips, and/or the contents of other playlists

• “Creating and adding an embedded page to a playlist” on page 6-7

• “Adding shared pages, scenes and clip assets to a playlist” on page 6-8

• “Appending or inserting the contents of a playlist to a playlist” on page 6-9

3. Determine which property columns you want displayed in the playlist.

• “Configuring the Playlist table columns” on page 6-11

4. Organize the playlist items

• “Repositioning playlist items within the playlist” on page 6-17 (optional)

• “Adding segments to the playlist” on page 6-19 (optional)

• “Adding comments to the playlist” on page 6-21 (optional)

• “Deleting playlist items from the playlist” on page 6-22 (optional)

5. Edit the playlist items’ properties

• “Editing the properties associated to the playlist items” on page 6-24 

6. Save the playlist

• “Saving a playlist” on page 6-26

Additional tasks that can be performed using the playlist are:

• “Reloading the playlist” on page 6-28
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Creating a new playlist
To create a new playlist, you must first open a new, empty Playlist Editor. If the Playlist 
Editor area is already occupied by another project (i.e. an existing playlist, rundown editor 
or segment window), performing the CREATE NEW PLAYLIST action (described below) 
immediately clears the Playlist Editor space and a blank Playlist Editor appears, ready for 
use.

To create a new playlist:

• Select FILE>NEW PLAYLIST.

Or,

• Click the CREATE NEW PLAYLIST button  in the Playlist toolbar. 

NOTE

Xbuilder’s Merge List and Make List / Air List features are alternative ways of creating playlists 
containing new pages and/or scenes from an Excel spreadsheet or XML file. See “Creating pages 
and/or scene using a Merge List” on page 3-4 and “Performing Quality Control (QC) and Media 
Check (MC)” on page 5-1 for more information.

Opening an existing playlist
Existing playlists are stored on the Xmedia Server. You can open existing playlists either 
from the Asset Browser or from the FILE menu.

To open an existing playlist using the Asset Browser:

1. Select the PLAYLISTS root category in the Asset Browser, and navigate to the 
appropriate category where the playlist is stored.

The playlists contained in the Asset Browser category is listed/displayed in the panel 
to the right of the Asset Browser.

2. Double-click the name of the desired playlist.

Or,

Right-click on the playlist’s name and select the OPEN command from the context 
menu.

The playlist opens in the Playlist Editor.

To open an existing playlist from the File menu:

1. Select FILE>OPEN PLAYLIST. 

The OPEN PLAYLIST dialog box appears.

2. Navigate through the Playlist categories in the right panel until the desired playlist is 
listed in the left panel.

3. Double-click the desired playlist listed in the right panel.

Or, 

Select the playlist and then click OK.

The playlist opens in the Playlist Editor.
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Verifying the contents of a playlist
When a playlist is opened in Xbuilder, you can run a verification of all of the items in the 
playlist to be certain that they have been published and are available on specific or all 
devices configured in Xbuilder’s Device Manager.

When a playlist verification is executed, each element in the playlist is verified as follows: 

• Checks if the assets used by the playlist element actually exist. 

• Checks if the assets that are used by the playlist element require the completion of a 
Work Order before they can be used. 

• Checks if the assets used by the playlist element are published on a specified device. 
If not, then it initiates the publishing of the assets.

There are two (2) ways in which you can perform a playlist verification: manual or 
automatic.

1. Open Xbuilder’s GENERAL settings page (TOOLS>SETTINGS>GENERAL) and choose a 
value for the VERIFY PLAYLIST setting:

• Choose AUTOMATIC if you want Xbuilder to automatically run a verification 
each time a playlist is opened in Xbuilder’s Playlist Editor.

• Choose MANUAL if you do not want playlists to automatically be verified each 
time they are opened in Xbuilder’s Playlist Editor.

NOTE

Regardless of whether you choose Automatic or Manual, you can manually execute a playlist 
verification at any time using the VERIFY PLAYLIST button  in the Playlist Editor’s toolbar.

2. In the NUMBER OF VERIFY DEVICES field on the GENERAL settings page, specify the total 
number of devices that you would like to set up in the Device Manager for the purposes 
of verifying playlist contents.

3. Click OK to close the Settings dialog box.

4. Open Xbuilder’s Device Manager (TOOLS>DEVICE MANAGER) and following the 
instructions on page 2-9 for adding and configuring devices for playlist verification.

5. Select from the DEVICE FOR VERIFY drop-down list, select the device(s) that you what 
to verify when the Verify Playlist task is executed. In the case where the playlist items 
already have a device assignment associated with them, you can select the USE 
PLAYLIST DEVICES option, otherwise choose a specific device.

6. If Xbuilder’s VERIFY PLAYLIST setting was set to AUTOMATIC, opening an existing playlist 
in Xbuilder results in an immediately playlist verification. 

If Xbuilder’s VERIFY PLAYLIST setting was set to MANUAL, the playlist is not verified upon 
opening. However, in either case, you can execute a playlist verification at any time by 
clicking the VERIFY PLAYLIST button  in the Playlist Editor’s toolbar.

The results of the playlist verification are reported directly in the playlist by highlighting 
erroneous items in red, as well as reporting problems in the item’s STATUS column.



6-6 Xbuilder User Manual

Creating and using playlists 

Populating a playlist
Playlists are a sequentially ordered list of the video clips, scenes and graphic pages of a 
show. As described on page 3-1, there are two (2) types of pages that can be added to a 
playlist: embedded pages and shared pages. Since shared pages exist in the Xmedia 
Server as distinct assets, they can be used in many different playlists as a common item. 
Embedded pages are unique and independent, in that they are not linked to any other 
playlists. Any and all edits to an embedded page therefore only affect the playlist that it 
belongs to.

The following sections provide instructions for adding embedded and shared pages to a 
playlist:

• “Creating and adding an embedded page to a playlist” on page 6-7

• “Adding shared pages, scenes and clip assets to a playlist” on page 6-8

NOTE

Templates that are stored in the Asset Browser can be dragged and added to playlists. In 
doing so, an instance of that template is automatically converted into an embedded page 
unique to that playlist. In other words, it becomes an embedded page based on the template.

After you have create and saved a few playlists, you might have the need to create a playlist 
whose contents is very similar to one that already exists. Rather than adding each page, 
scene and clip individually again, you may want to append or insert the contents of the 
existing playlist (pages and clips) to the new playlist. See “Appending or inserting the 
contents of a playlist to a playlist” on page 6-9 for instructions on using this method for 
populating a playlist.

Figure 6-2. An example of a playlist that contains graphic pages, clips, segments, and comments
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Creating and adding an embedded page to a playlist

Creating and adding a new embedded page to the playlist results in the page existing only 
in that specific playlist, not as an asset in the Asset Browser to be used in additional 
playlists. 

The following instructions describe the commonly used method of creating a new 
embedded page from a template, followed by some alternative methods.

To create a new page from a template and add it to the playlist as an embedded page:

1. Click the INSERT NEW PAGE button  in from playlist’s toolbar.
The SELECT A TEMPLATE FOR THE NEW GRAPHIC dialog box appears.

2. Navigate to the appropriate template asset within the TEMPLATES root category and 
sub-categories.

3. Double-click the template asset listed.

The template opens in the Template Editor.

Or,

Select the template in the Template Editor and click OK.
The template opens in the Template Editor.

4. Set or edit the variable fields in the template as required (see “Editing a page or scene’s 
content elements” on page 3-10 for assistance).

5. Optional: Preview the playout of the page using the PREVIEW PAGE command  in 
the Template Editor’s toolbar (see “Previewing a page or scene on the Preview device” 
on page 3-11).

6. Select the row in the playlist where you would like the page to be inserted (the page is 
inserted below the selected row).

7. Click the INSERT IN PLAYLIST AND CLOSE button  from the Template Editor’s 
toolbar.

The page is immediately added to the playlist below the selected playlist row and the 
template closes leaving the Template Editor empty.

Alternative ways of creating and adding an new embedded page from a template 
include:

• Navigate through the Asset Browser’s TEMPLATES categories until the desired template 
is listed in the panel to the right of the Asset Browser. Select the desired template asset 
from the Template Editor and drag and drop it into the playlist.

• With a template open in the Template Editor, drag and drop the  icon (located in the 
upper portion of the Template Editor) into the playlist.

• If you have populated the Favorites Browser with existing templates, you can drag and 
drop these templates from the Favorites Browser into the playlist.

• Open a Merge List in Xbuilder and all of the new pages that are created are added to 
a new playlist as embedded pages until they are approved (then they become shared 
pages). See “Creating pages and/or scene using a Merge List” on page 3-4 for more 
information.
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Adding shared pages, scenes and clip assets to a playlist

Shared pages, scenes and clips are three asset types that can be added to different 
playlists. Although these assets are stored on the Xmedia Server, they are accessible to 
Xbuilder through the Asset Browser.

NOTE

Since shared pages exist in the Xmedia Server as distinct assets, they can be used in many 
different playlists as a common item. A noteworthy drawback of using shared pages in 
multiple playlists is that if the shared page is edited or deleted, you will (perhaps 
unintentionally) affect all of the playlists that contain that shared page.

The following instructions describe how to add shared pages, scenes and clip asset to a 
playlist by dragging the asset from the Asset Browser to the playlist. If however, the shared 
page or scene is already open in the Template Editor, a second set of instructions describes 
how to add that page or scene to the playlist.

To add a shared page, scene or clip asset to the playlist:

1. Select the PAGES, SCENES or CLIPS root category in the Asset Browser, and navigate 
to the appropriate category where the asset is stored.

The assets contained in the pages, scenes or clips categories are then listed/displayed 
in the panel to the right of the Asset Browser.

2. Select the desired asset and drag it into the Playlist Editor.

Notice that a highlighted horizontal line appears in the Playlist Editor as you drag the 
pointer over the various rows in the playlist. This line indicates the location of where the 
asset will be inserted in the playlist. 

NOTE

A fully extended Insert Line indicates that the asset will be added to the playlist as a primary 
event, while a partially extended line indicates that it will be added as a secondary event 
(see “Repositioning primary playlist items (clips, scenes, pages, or comments)” on page 
6-17 and “Adding a secondary event to a primary event in a playlist” on page 6-18 for more 
information.

3. Drop the asset into the playlist by releasing the mouse button. 

To add an opened shared page or scene to the playlist:

1. With a shared page or scene open in the Template Editor, select the playlist row where 
you want the page to be inserted (the page will be inserted below the selected row).

2. Click the SAVE PAGE, INSERT IN PLAYLIST button  located in the Template Editor’s 
toolbar.

Any unsaved changes that were made to the page or scene are immediately saved and 
the page/scene is added to the playlist below the selected playlist row.
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Appending or inserting the contents of a playlist to a playlist

Rather than adding pages, scenes, templates, and clips individually to a playlist, you can 
add the entire contents of an existing playlist (including segments and comments) to a 
playlist. This avoids having to recreate the contents of a playlist that already exists.

NOTE

Adding the contents of a playlist to another playlist is a legitimate way of copying embedded 
pages from one playlist to another.

As described below, there are three (3) ways to add the contents of an existing playlist 
assets to a playlist:

• Drag and drop the playlist asset from the Asset Browser into the Playlist Editor.

• Use the APPEND PLAYLIST command.

• Use the INSERT PLAYLIST command.

To add the contents of an existing playlist to a playlist by dragging and dropping the 
playlist asset:

1. Select the PLAYLISTS root category in the Asset Browser, and navigate to the 
appropriate category where the playlist asset is stored.

The assets contained in the Playlists category are then listed/displayed in the panel to 
the right of the Asset Browser.

2. Select the desired playlist asset and drag it into the Playlist Editor.

Notice that a highlighted horizontal line appears in the Playlist Editor as you drag the 
pointer over the various rows in the playlist. This line indicates the location of where the 
playlist will be inserted in the playlist.

NOTE

A fully extended Insert Line indicates that the playlist will be added as a primary event, while a 
partially extended line indicates that it will be added as a secondary event (see “Repositioning 
primary playlist items (clips, scenes, pages, or comments)” on page 6-17 and “Adding a 
secondary event to a primary event in a playlist” on page 6-18 for more information.

3. Drop the playlist asset into the playlist by releasing the mouse button.

The entire contents of the playlist asset is added immediately to the playlist, including 
all pages, templates, scenes, clips, segments, and comments that were contained in 
the playlist asset.
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To add the contents of an existing playlist to a playlist using the APPEND PLAYLIST 
command:

1. Open in the playlist to be added in the Playlist Editor and then select the FILE>APPEND 
PLAYLIST menu command.

The APPEND PLAYLIST dialog box appears.

2. Navigate through the APPEND PLAYLIST dialog box and select the playlist asset that you 
want to add (append) to the end of current playlist.

3. Click OK, or double-click the playlist’s asset name in the APPEND PLAYLIST dialog box.

The entire contents of the playlist asset is added immediately to the bottom portion of 
the playlist, including all pages, templates, scenes, clips, segments, and comments 
that were contained in the playlist asset.

To add the contents of an existing playlist to a playlist using the INSERT PLAYLIST 
command:

1. Open in the playlist to be added in the Playlist Editor and then select the playlist row 
where you want the contents of the playlist to be inserted (the contents will be inserted 
below the selected row).

2. Select the FILE>INSERT PLAYLIST command from the Xbuilder menus.

The INSERT PLAYLIST dialog box appears.

3. Navigate through the INSERT PLAYLIST dialog box and select the playlist asset that you 
want to add (insert in) to the end of current playlist.

4. Click OK, or double-click the playlist’s asset name in the INSERT PLAYLIST dialog box.

The entire contents of the playlist asset is added immediately below the selected playlist 
row, including all pages, templates, scenes, clips, segments, and comments that were 
contained in the playlist asset.
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Configuring the Playlist table columns
The playlist table’s columns display information about each page, template, scene, or clip 
included in the playlist/segment. Using the COLUMN LAYOUT dialog box (figure 6-3), you can 
determine which columns are displayed or hidden in the playlist. You can also determine 
the order in which the columns appear in the playlist.

Column headings that are currently displayed in the playlist are listed in the SELECTED 
COLUMNS text box (on the right), while hidden column headings are listed in the AVAILABLE 
COLUMNS text box (on the left). Customizing the playlist column means simply moving the 
headings from on side to the other (see the instructions below). The COLUMN LAYOUT dialog 
box conveniently also offers two (2) standard layouts: BASIC and FULL.

Figure 6-3. Column Layout dialog box

The following table lists and describes all of the available column categories that can be 
displayed in the Playlist Editor:

DESCRIPTION Displays a user provided text that describes the playlist item. 

The description text is originally created by filling in the 
DESCRIPTION field on the SAVE dialog box when the item is 
originally saved as an asset.

You can also add/edit the description text of a page, template, 
scene or clip asset by editing the Description field in the 
Template Editor when the asset is opened. See “Editing the 
properties associated to the playlist items” on page 6-24 for 
more information.

DEVICE Identifies the device to which the page, template, scene or clip 
will be sent.

DURATION Identifies the length of time that the page, template, scene or 
clip stays on air during the playout of the playlist.
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MARK IN Displays the frame location that will be used as a starting point 
when the clip asset is played out in the playlist. As is described 
in “Editing the properties associated to the playlist items” on 
page 6-24, this property is set using the MARKIN/OUT EDITOR. 

MARK OUT Displays the frame location that will be used as an ending point 
when the clip asset is played out in the playlist. As is described 
in “Editing the properties associated to the playlist items” on 
page 6-24, this property is set using the MARKIN/OUT EDITOR.

NAME Displays the name of the playlist item.

See “Editing the properties associated to the playlist items” on 
page 6-24 for information regarding editing the name of 
specific playlist items.

OFFSET Identifies the amount of time delay between the playout of two 
consecutive playlist elements. 

OVERFLOW Identifies the difference between the total time of the content in 
a timeslot and the time available in the timeslot. When the total 
time of the content in a timeslot exceeds the time available, 
there is an overflow. 

PLAYOUT TYPE Indicates the method by which the playlist item (i.e page, 
template, scene, clip) be cued to air:

• SEQUENTIAL : The playlist element is played when the 
previous element has completed (possibly with an offset).

• HARD START : The playlist element is played at the 
specified time of day. If required, the currently playing 
element will be preempted. When a hard start element is 
played the playlist is synchronized with the system clock. 
The time of day is specified by entering it into the Offset 
column.

• MANUAL : The playlist element is played when a 
RESUME command is sent to the playlist. If this command 
arrives earlier than expected, the currently playing 
element is preempted. If the command arrives later than 
expected, the playlist waits before resuming playout. The 
RESUME command can be sent from the PLAY button in 
Xplay, or from logic in the Panel.

RECALL ID Displays the Recall ID for the page, template, scene or clip, 
which is used by other Vertigo Suite applications as a shortcut 
identifier for calling up pages and templates.

The Recall ID is originally created by filling in the RECALL ID 
field on the SAVE dialog box when the page or template is 
originally saved as an asset.
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The following sections explain how to customize the playlist table’s columns. 

• “Adding columns to a playlist” on page 6-13

• “Removing columns from a playlist” on page 6-14

• “Creating, renaming, and deleting your custom column headings” on page 6-14

• “Reordering the columns in a playlist” on page 6-15

• “Using the standard column layouts: Basic or Full” on page 6-15

NOTE

For instructions on modifying column information for playlist items, refer to “Editing the 
properties associated to the playlist items” on page 6-24.

Adding columns to a playlist

Complete the following steps to add one or many columns to a playlist:

1. Select TOOLS>CONFIGURE PLAYLIST COLUMNS.

The COLUMN LAYOUT dialog box appears. The current playlist columns are listed in the 
SELECTED COLUMNS text box, while hidden column headings are listed in the 
AVAILABLE COLUMNS text box.

2. Select the desired column heading(s) from the AVAILABLE COLUMNS text box.

The column heading’s name is highlighted in blue when it is selected. To deselect, 
simply click the heading again.

3. Click the RIGHT ARROW  button.

The selected column headings immediately move to the SELECTED COLUMNS text box.

4. Click APPLY to implement the changes immediately to the playlist, while keeping the 
Column Layout dialog box open for further edits to the playlist columns.

Or,

Click OK to implement the changes immediately to the playlist and close the Column 
Layout dialog box.

Or, 

Click CANCEL to abort the changes and maintain the playlist as it was.

STATUS When the VERIFY PLAYLIST setting is enabled, each element in 
the playlist is verified when the playlist is loaded to ensure that 
it is available and ready for use. The results of the verification 
are displayed in the Status column for each element. See 
“Adding and configuring a Preview device” on page 2-7 for 
more information. The playlist item’s on-air or cued status is 
also displayed in this column.
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Removing columns from a playlist
Complete the following steps to remove one or many columns from a playlist:

1. Select TOOLS>CONFIGURE PLAYLIST COLUMNS.

The COLUMN LAYOUT dialog box appears. The current playlist columns are listed in the 
SELECTED COLUMNS text box, while hidden column headings are listed in the 
AVAILABLE COLUMNS text box.

2. Select the desired column heading(s) from the SELECTED COLUMNS text box.

The column heading’s name is highlighted in blue when it is selected. To deselect, 
simply click the heading again.

3. Click the LEFT ARROW  button.

The selected column headings immediately move to the AVAILABLE COLUMNS text box.

4. Click APPLY to implement the changes immediately in the playlist, while keeping the 
Column Layout dialog box open for further edits to the playlist columns.
Or,
Click OK to implement the changes immediately to the playlist and close the Column 
Layout dialog box.
Or, 
Click CANCEL to abort the changes and maintain the playlist as it was.

Creating, renaming, and deleting your custom column headings
To better reflect the particular contents of your playlist, the COLUMN LAYOUT dialog box allows 
you to create your own (user defined) column headings. Once it has been created, you can also 
rename the column heading or delete it from the Column Layout dialog box by right-clicking on 
the name and selecting either the RENAME or DELETE command from the context menu.

NOTE

Only custom column headings can be renamed and deleted from the Column Layout dialog box.

To create a custom playlist column heading:

1. Select TOOLS>CONFIGURE PLAYLIST COLUMNS.

The COLUMN LAYOUT dialog box appears.

2. Click the ADD button.

The ADD COLUMN dialog box appears.

3. Type the name of the new column in the text box and click OK.

The new column heading’s name immediately appears in the SELECTED COLUMNS text 
box on the COLUMN LAYOUT dialog box.

4. Click APPLY to immediately add the new column to the playlist, while keeping the 
Column Layout dialog box open for further edits to the playlist columns.
Or,
Click OK to immediately add the new column to the playlist and close the Column 
Layout dialog box.
Or, 
Click CANCEL to abort the changes and maintain the playlist as it was.
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Reordering the columns in a playlist

The order in which the column appear in the Playlist Editor is determined by the column 
heading’s position in the 

Complete the following steps to reorder one or many columns in a playlist:

1. Select TOOLS>CONFIGURE PLAYLIST COLUMNS.

The COLUMN LAYOUT dialog box appears. The current playlist columns are listed in 
order the SELECTED COLUMNS text box.

2. Select the column heading(s) that you want to move to another position from the 
SELECTED COLUMNS text box.

The column heading’s name is highlighted in blue when it is selected. To deselect, 
simply click the heading again.

3. Click the UP ARROW  button once for each position that you want to move the 
column to the left in the playlist.

Or, 

Click the DOWN ARROW  button once for each position that you want to move the 
column to the right in the playlist.

4. Click APPLY to implement the changes immediately in the playlist, while keeping the 
Column Layout dialog box open for further edits to the playlist columns.

Or,

Click OK to implement the changes immediately to the playlist and close the Column 
Layout dialog box.

Or, 

Click CANCEL to abort the changes and maintain the playlist as it was.

Using the standard column layouts: Basic or Full

The Column Layout dialog box offers two (2) preset standard layouts:

• BASIC - Includes only the Name, Device and Status columns.

• FULL - Includes all columns.

These standard layouts are convenient ways of populating or removing columns from the 
Playlist Editor.

To select a standard layout playlist format:

1. Select TOOLS>CONFIGURE PLAYLIST COLUMNS.

The COLUMN LAYOUT dialog box appears. The current playlist columns are listed in the 
SELECTED COLUMNS text box, while hidden column headings are listed in the 
AVAILABLE COLUMNS text box.

2. Select either BASIC or FULL from the STANDARD LAYOUT drop-down list.

3. Click the SELECT button.

The SELECTED COLUMNS and AVAILABLE COLUMNS text boxes are immediately 
appropriately populated.
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4. Click APPLY to implement the changes immediately in the playlist, while keeping the 
Column Layout dialog box open for further edits to the playlist columns.

Or,

Click OK to implement the changes immediately to the playlist and close the Column 
Layout dialog box.

Or, 

Click CANCEL to abort the changes and maintain the playlist as it was.
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Repositioning playlist items within the playlist
Pages, scenes and clips are added to the playlist as primary scheduled events. Once added 
to the playlist, you can reposition the items within the playlist by dragging and dropping them 
to the desired row location. 

When a clip is a primary event in the playlist, you can reposition pages and scenes within 
the playlist to become secondary events to the clip. Making a page or scene a secondary 
event to a clip allows you to set the page or scene’s offset and duration with respect to the 
clip (primary event), rather than to the beginning of the playlist.

The following sections provide instructions for repositioning items within the playlist:

• “Repositioning primary playlist items (clips, scenes, pages, or comments)” on page 
6-17

• “Adding a secondary event to a primary event in a playlist” on page 6-18

NOTE

Also see “Adding segments to the playlist” on page 6-19 for instructions for how to move 
playlist items into, or out of, playlist segments.

Repositioning primary playlist items (clips, scenes, pages, or 
comments)

To reposition a playlist item:

1. Select the playlist item that you want to move to a new location.

2. Click and drag the selected playlist item into the desired playlist row. 

As you drag, a insert line (red line by default) extends across the table, which indicates 
where the item will be placed (figure 6-4). 

3. Release the mouse button to drop the item in its new location.

Figure 6-4. Drag and drop the playlist item to the desired row location
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Adding a secondary event to a primary event in a playlist

Making a page or scene a secondary event to a clip allows you to set the page or scene’s 
offset and duration with respect to the clip (primary event), rather than to the beginning of 
the playlist. 

To add a secondary event to a primary event:

1. Add a clip to the playlist as a primary event by dragging the clip asset from the Asset 
Browser and dropping it into the desired location in the playlist.

2. Add a page or scene to the playlist as a secondary event to the clip by dragging the 
asset from the Asset Browser to the row below the clip’s name in the playlist. 

Before you drop it, take note of the following:

• Whether or not the primary event heading changes color. If the primary 
event heading changes color, the page/scene will become a secondary event. 
If it does not, then the item will be placed below the primary event as an 
additional primary event.

• The length of the insert line (red by default). If the insert line runs the entire 
width of the playlist, then the page/scene is being moved outside the primary 
event. If the line shortens, it means that the page will become a secondary 
event (see below).

• Blue box: Once page/scene has been added to the primary event, it is 
bordered at left by a blue box (see below).

3. Drop the page/scene into the playlist by releasing the mouse button.

NOTE

To make a page or scene that already exists as a primary event in the playlist a secondary 
event of a clip in that same playlist, simply drag the page/scene from its current location to 
the row under the clip in the same way that is described in step 2 and 3 above.

A fully extended insert line adds the page/scene as a primary object

A partially extended insert line adds the page/scene as a secondary object to the primary object
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Adding segments to the playlist
You can insert segments into your playlists to group together related playlist items under 
common headings (figure 6-5). This allows you to:

• See at a glance how items in a playlist have been organized thematically (e.g. Headlines, 
Sports, Business, Entertainment).

• Move the contents of a segment at once. This is useful if, for example, at the last minute you 
decide that the pages organized under Business should be placed before the Sports segment.

Figure 6-5. Playlist segments allow you to put pages, templates, scenes and clips into thematic groupings

NOTE

Playlist segments are different from the segment assets that are listed in the Asset 
Browser’s SEGMENTS root category. Segment assets are stored on the Xmedia Server and 
made available in the Asset Browser for creating rundowns, while playlist segments are 
only available to the playlist in which they are a part of.

To add a segment to the playlist:

1. Select the playlist row where you want the segment to be inserted (the segment 
heading will be inserted above the selected row).

2. Right-click on the row and select the ADD SEGMENT command from the context menu 
that appears (figure 6-6). 

The segment heading is added above the selected row with the name open for editing.

Figure 6-6. Use the ADD SEGMENT command to insert a segment heading into the playlist
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3. Enter a name for the segment and press ENTER. 

At this point the segment is empty, even if pages, scenes, clips or templates appear to 
be beneath it. You now need to add items to the segment.

4. Click and drag the selected playlist item into the desired segment. As you drag, a red line 
indicates where the item will be placed. Before you drop it, take note of the following:

• Whether or not the segment heading changes color. If the segment heading does 
change color, the item will become part of the segment. If it does not, then the item 
will be placed outside of the segment.

• The length of the insert line (red by default). If the insert line runs the entire width 
of the playlist, then the item is being moved outside the segment. If the line shortens, 
it means that the item is being moved into the segment (see below).

• Blue box: Once items have been added to a segment, they are bordered at left by a 
blue box (see below).

When the insert line is fully extended, the item will be moved outside of the segment.

When the insert line is not fully extended and the border turns color, the item will be inserted into the segment.
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Adding comments to the playlist
Annotating your playlist by adding comments often benefits the person operating the 
playlist. Your comments should be concise, yet identify the purpose or behavior of elements 
in your playlist.

To add comments to the playlist:

1. Select the playlist row where you want the comment to be inserted (the comment will 
be inserted above the selected row).

2. Right-click on the row and select the ADD COMMENT command from the context menu 
that appears (figure 6-7). 

The comment row is added above the selected row with the text ready for editing.

Figure 6-7. Use the ADD COMMENT command to insert an annotation into the playlist

3. Type the text for the comment and press ENTER. 

To edit the text of a comment row that is already inserted into the playlist:

1. Select the comment row who’s text is to be edited.

2. Right-click on the row and select the EDIT CELL command from the context menu that 
appears (figure 6-8). The comment row text becomes ready for editing.

Figure 6-8. Use the EDIT CELL command to change the text in a playlist annotation

3. Type the new text for the comment and press ENTER.
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Deleting playlist items from the playlist
While building or using the playlist, you may want to remove an item that was previous 
added to the playlist (i.e. a page, scene, template, clip, playlist segment, or comment). 

NOTE

If the page, template, scene or clip that is to be deleted is a saved asset, deleting the item 
from the playlist does not remove the asset from the system, only from the playlist. 
However, embedded pages, playlist segments, and comments that were added to the 
playlist, but are not assets, will be completed deleted from the system.

The following instructions describe how to delete items from the playlist, as well as how to 
delete all playlist items in one action.

To delete an individual item from the playlist:

1. Select the item that you would like to delete from the playlist.

2. Right-click on the item’s row and select the DELETE command from the context menu.

Or,

Press the DELETE key on your keyboard.

3. If Xbuilder’s CONFIRM PAGE DELETION property (TOOLS>SETTINGS>AUTOMATION) is 
enabled, the CONFIRM DELETE dialog box appears. Select YES and the item is 
immediately deleted from the playlist, or select NO to cancel the delete action.

If however Xbuilder’s CONFIRM PAGE DELETION property 
(TOOLS>SETTINGS>AUTOMATION) is disabled, then the item is immediately deleted from 
the playlist.

To delete multiple items from the playlist:

1. Select the first item that you would like to delete from the playlist.

2. While holding down the CTRL key, select the various items that you would like to delete 
from the playlist.

3. Right-click on one of the selected items and select the DELETE command from the 
context menu.

Or,

Press the DELETE key on your keyboard.
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To delete a consecutive grouping of items from the playlist:

1. Select the first item that you would like to delete from the playlist.

2. While holding down the SHIFT key, select the last item that you would like to delete from 
the playlist.

The first, last, and all items between these two become selected forming the group of 
items to be deleted from the playlist.

3. Right-click within the grouping and select the DELETE command from the context menu.

Or,

Press the DELETE key on your keyboard.

4. If Xbuilder’s CONFIRM PAGE DELETION property (TOOLS>SETTINGS>AUTOMATION) is 
enabled, the CONFIRM DELETE dialog box appears. Select YES and the items are 
immediately deleted from the playlist, or select NO to cancel the delete action.

If however Xbuilder’s CONFIRM PAGE DELETION property is disabled, then the items are 
immediately deleted from the playlist.

To delete the entire contents of the playlist in one action:

1. Select the ACTIONS>CLEAR PLAYLIST command from Xbuilder’s menu commands.

Or,

Press F8.

2. If Xbuilder’s CONFIRM PLAYLIST CLEAR property (TOOLS>SETTINGS>AUTOMATION) is 
enabled, the CLEAR PLAYLIST dialog box appears. Select YES and the items in the 
playlist are immediately deleted and the playlist is left empty. Or, select NO to cancel 
the clear playlist action.

If however Xbuilder’s CONFIRM PAGE DELETION property is disabled, then the playlist 
items are immediately removed from the playlist, leaving an empty playlist.
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Editing the properties associated to the playlist items
Each item that is added to the playlist is arranged as a row in the Playlist Editor. Some of 
the properties that are associated with the item are identified in the column cells that run 
along the playlist row. You can change certain playlist item properties from within the 
playlist. The following table explains how to edit each playlist column. 

NOTE

See “Configuring the Playlist table columns” on page 6-11 for a description the available 
playlist column categories, as well as how to display/hide the column categories.

DESCRIPTION You cannot change a page, template or scene description from within 
the Playlist Editor since it’s a fundamental property of the asset.

However, if you still would like to add/edit the description text, double-
click the item’s row in the playlist. The item opens in the Template 
Editor. Type the text in the Description field in the upper portion of the 
Template Editor. If the item was a page, click the SAVE PAGE, AND 
CLOSE button  in the Template Editor. If the item was a template, 
click the COMMIT AND CLOSE button  in the Template Editor. The 
playlist’s Description column now displays the added/edited text.

DEVICE The name of the output device to which the playlist item will be sent 
when it is played out in Xplay.

DURATION The duration of time a playlist item stays on air can be modified by 
selecting the row and then clicking once in the Duration column cell. 
Type in the amount of time that you would like the item to stay on air for 
(i.e. 00:00:01 is one second). Then press ENTER.

See “Playlist > Basic settings” on page 9-16 for a description of the 
SHOW HOURS IN DURATION COLUMN setting, which determines the format 
of the Duration value in the playlist column.

MARK IN To edit the value in the Mark In column for clip items in the playlist, 
select the clip row in the playlist. Right-click on the Mark In column cell 
and select the VISUAL MARKIN/MARKOUT command from the context 
menu. The MarkIn/Out Editor window appears. Use the left handle on 
the slider to adjust the Mark In value and then click APPLY.

MARK OUT To edit the value in the Mark Out column for clip items in the playlist, 
select the clip row in the playlist. Right-click on the Mark Out column cell 
and select the VISUAL MARKIN/MARKOUT command from the context 
menu. The MarkIn/Out Editor window appears. Use the right handle on 
the slider to adjust the Mark Out value and then click APPLY.
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NAME You cannot rename a page, template, scene or clip from within the 
Playlist Editor since it’s a fundamental property of the asset.

However, if you still would like to edit the name of the item in the playlist, 
double-click the row in the playlist. The item opens in the Template 
Editor. Type the new name in the Name field in the upper portion of the 
Template Editor. Click the COMMIT AND CLOSE button  in the 
Template Editor. The playlist’s Name column now displays the edited 
name.

To edit the name of a playlist segment, right-click the segment headings 
row and select the EDIT CELL command from the context menu. Type 
the new text and press ENTER.

See “Adding comments to the playlist” on page 6-21 for instructions on 
how to edit the text in a comment row.

OFFSET The offset time, which represents the amount of time delay between the 
playout of two consecutive playlist elements, can be modified by 
selecting the row and then clicking once in the Offset column cell. Type 
in the amount of time that you would like to be between the playout of 
the playlist items (i.e. 00:00:01 is one second). Then, press ENTER. 

See “Display settings” on page 9-4 for a description of the OFFSET 
DISPLAY FORMAT setting, which determines the format of the Offset 
value in the playlist column.

OVERFLOW Currently, you cannot edit the overflow column’s value in Xbuilder’s 
Playlist Editor.

PLAYOUT TYPE The Playout Type column’s setting, as indicated by an icon, can be 
changed by right-clicking on the playout type’s column’s cell, and then 
selecting the PLAYOUT TYPE command from the context menu. Select 
one of the following playout types styles: SEQUENTIAL, HARD START, or 
MANUAL. See page 6-12 for more information about the three (3) 
playout types.

RECALL ID The Recall ID column’s value cannot be changed from within the 
Playlist Editor since it’s a fundamental property of the page or template.

However, if you still would like to add/edit the Recall ID for a particular 
page, double-click the page’s row in the playlist. The page opens in the 
Contents Editor. Type the text in the Recall ID field in the upper portion 
of the Template Editor. Click the SAVE PAGE, AND CLOSE button  in 
the Template Editor. The playlist’s Recall ID column now displays the 
added/edited text.

STATUS Displays the results of a verification routine when the playlist is loaded, 
as well as the item’s on-air or cued status.
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Saving a playlist
For a playlist to be available for future use, or accessible to other Vertigo Suite applications 
(i.e. Xplay), the playlist must be saved to the Xmedia Server. Newly created playlists are 
given a generic name (i.e. Playlist1) until they are saved and you specify a unique name.

As well, any edits that are performed to existing playlist are not permanent until the playlist 
has been saved. A playlist with unsaved edits is indicated by an asterisks beside the 
playlist’s name in the Playlist Editor. 

When a playlist is saved to the system, it becomes a playlist asset. Playlist assets are stored 
and accessed from within the PLAYLISTS root category (and sub-categories) in the Asset 
Browser and listed in the Template Editor.

To save a newly-created playlist:

1. Select the FILE>SAVE PLAYLIST command from Xbuilder’s menu commands. 

Or,

Press CTRL+S.

Or,

Click the SAVE CURRENT PLAYLIST  button in the Playlist Editor’s toolbar.

The SAVE PLAYLIST dialog box appears (figure 6-9).

Figure 6-9. The Save Playlist dialog box

2. In the NAME field enter a new name for the playlist.

3. Enter your name in the AUTHOR field (optional).

4. Enter a short description for the playlist in the DESCRIPTION field (optional).

5. Link the playlist to the Playlists root category or to sub-categories by selecting the 
check box for each place where you want the playlist to be accessible from.

6. Click OK to save the playlist and exit the dialog box.

Or,

Click CANCEL to discard all entered information and return to the unsaved playlist.
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To save the changes to an existing playlist:

• Select the FILE>SAVE PLAYLIST command from Xbuilder’s menu commands. 

Or,

• Press CTRL+S.

Or,

• Click the SAVE CURRENT PLAYLIST  button in the Playlist Editor’s toolbar.

To save an existing playlist under a different name or into another category:

1. Select the FILE>SAVE PLAYLIST AS command from Xbuilder’s menu commands. 

Or,

Click the SAVE CURRENT PLAYLIST AS  button in the Playlist Editor’s toolbar.

The SAVE PLAYLIST dialog box appears (figure 6-9).

2. In the NAME field enter a new name for the playlist.

3. Enter your name in the AUTHOR field (optional).

4. Enter a short description for the playlist in the DESCRIPTION field (optional).

5. Link the playlist to the Playlists root category or to sub-categories by selecting the 
check box for each place where you want the playlist to be accessible from.

6. Click OK to save the playlist and exit the dialog box.

Or,

Click CANCEL to discard all entered information and return to the unsaved playlist.

NOTE

If you only want to move an existing playlist to another category, you don’t necessarily have 
to perform a Save As. Simply drag and drop the playlist from the Template Editor from its 
current category to another within the Asset Browser.
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Reloading the playlist
If you’ve had a playlist open for a while you may need to reload it to ensure that it’s still up-
to-date. For example, additional items may have been appended to the playlist by a user at 
another workstation while the playlist was also open at your workstation.

To reload the playlist:

• Select the ACTIONS>RELOAD PLAYLIST command from Xbuilder’s menu commands.

Or,

• Press F5.

Or,

• Click the RELOAD PLAYLIST button  in the Playlist Editor’s toolbar.
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7 CREATING AND USING RUNDOWNS AND 
SEGMENTS

Xbuilder allows you to create rundowns, which are ordered lists of the thematic RUNDOWN 
SEGMENTS that make up a program. In turn, the rundown segments are lists of the graphic 
pages (shared and embedded), scenes, and/or clips. The order in which the items are listed 
in the rundown determines their playout order as well.

There are two types of rundown segments: shared segments and embedded segments.

• Shared segments are segment lists that are created and saved as assets on 
the Xmedia Server. These segments are accessed through the Asset 
Browser’s SEGMENTS root category and they can be added to any rundown.

• Embedded segments are similarly created, but rather than being saved as 
independent assets, they are saved as part of the rundown. Embedded 
segments therefore, can only be used by the rundown that it belongs to.

NOTE

Although rundown segments appear very similar to playlists, be aware that there are 
differences between the two and that you should make assumptions that their functionality 
is the same. For example, you cannot add the contents of a playlist to a rundown segment 
if the playlist’s pages are organized within playlist segments.

The following sections provide descriptions and instructions for how to create and edit 
rundowns and segments in Xbuilder:

• “An overview of the Rundown Editor” on page 7-3

• “Procedural overview for creating rundowns” on page 7-6

• “Creating a new rundown” on page 7-7

• “Opening an existing rundown” on page 7-8

• “Creating and using rundown segments” on page 7-9

• “Opening an existing rundown segment” on page 7-18
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• “Adding segments to a rundown” on page 7-19

• “Repositioning segments within the rundown” on page 7-21

• “Removing segments from a rundown” on page 7-22

• “Saving a rundown under a different name or category” on page 7-23

• “Deleting a rundown from the system” on page 7-24
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An overview of the Rundown Editor
The Rundown Editor lists the content and playback order for a program. A rundown is 
populated and organized using rundown segments that are built and edited in the Segment 
Editor or the Segment window. Figure 7-1 demonstrates that the Segment Editor appears 
to the right of the Rundown Editor and is used mainly to view and edit the segments 
belonging to the rundown.

Figure 7-1. Rundown Editor components

Figure 7-1 and the following table identifies and describes the components of the Rundown Editor:

Rundown name New rundowns are given a temporary default name of Rundown#, which 
appears in the first row of the Rundown list. Once you save the rundown, 
the default name is replaced with its new name. Rundowns are saved on 
the Xmedia Server as assets and are available to Xbuilder through the 
Asset Browser’s Rundowns root category.

Rundown segments Each row in the Rundown Editor represents an individual rundown 
segment. Rundown segments are built and viewed in the Segment 
Editor/Window and can consist of a single page or a series of pages. 

When you select a segment in the Rundown Editor, the row’s background 
changes color. When the segment is open the Segment Editor, the 
segment’s name is highlighted in the Rundown Editor. These color settings 
can be changed using Xbuilder’s segment color settings.

Rundown Editor’s 
menu commands

The Rundown Editor also features a context menu that allows you to save, 
rename or delete the segment that is selected in the Rundown Editor.

Rundown name

Rundown segments

Segment open in
Segment Editor

Rundown Editor’s
menu commands
(right-click)



7-4 Xbuilder User Manual

Creating and using rundowns and segments 

An overview of the Segment Editor & Segment Window
Xbuilder offers two interfaces for creating and editing rundown segments: the Segment Editor 
and the Segment window. 

• The SEGMENT EDITOR (figure 7-2) is joined to the Rundown Editor and it allows you to:

• Create and populate new rundown segments with pages and playlists.

• Add the segments to the rundown that is open in the Rundown Editor.

• Save the segment as shared segment (using the SAVE AS button) or as an 
embedded segment (using the SAVE button).

• View, add, edit, or remove pages, scene or clips belonging to the segment 
highlighted in the Rundown window. 

Figure 7-2. The Rundown Window and the Segment Editor

The SEGMENT WINDOW (figure 7-3) is a standalone interface (meaning that it is not 
associated with a specific rundown) that allows you to create and populate new shared 
rundown segments with pages, scenes, clips and playlists.

Figure 7-3. The Segment window is a stand-alone interface for creating and editing shared segments

Figure 7-3 and the following list identify and describe the main interface components

1. TOOLBAR: A series of buttons that allows you to perform actions related to creating, 
saving, and populating segments. See “Segment Editor toolbar” on page 8-17 for a 
description of each button on the toolbar.

2. SEGMENT: A list of the pages, scenes and clips that make up the content of the segment. 
Each page, scene, or clip has a dedicated row in the Segment Editor/window, which 
determines their intended playout order. See “Adding pages to a rundown segment” on page 
7-11 and “Repositioning pages within the rundown segment” on page 7-15 for more 
information.

Like playlists, the columns display information about each item included in the rundown 
segment. Xbuilder allows you to determine which columns are displayed or hidden in 
the Segment Editor/window by using the COLUMN LAYOUT dialog box. See “Configuring 
the Playlist table columns” on page 6-11 for instructions on how to display or hide 
certain columns.

1

4

2

53



Xbuilder User Manual 7-5

Creating and using rundowns and segments 

You can annotate the segment by adding comment rows. Comment rows are often 
used to insert instructions or identification annotations so that operators are better 
informed. See “Adding a comment row to the rundown segment” on page 7-14 for more 
information.

3. MENU COMMANDS: Right-clicking on a segment row exposes menu commands that 
allows you to set the playout type or delete the selected segment row. When these 
commands are opened on a clip row, the VISUAL MARK IN/MARK OUT command can be 
used to edit the clip’s starting and ending times. The two other commands allow you to 
insert a segment or comment above the currently selected segment.

4. NAME: Displays the name of the rundown segment that is currently displayed in the Segment 
window. An asterisk appears beside the name until the segment, or the edits to the segment, 
have been saved. See “Saving a rundown segment” on page 7-17 for more information.

5. DEVICE FOR VERIFY: In the same way that Xbuilder allows you to verify the presence and 
publishing of playlist items on configured devices, Xbuilder can also manually verify the 
contents of a segment on specified devices using the VERIFY SEGMENT button .

This particular interface component allows you to target a specific device or all of the 
configured devices when a segment verification is executed. 

See “Configuring a device for the verification of playlist elements” on page 2-9 and 
“Verifying the contents of a playlist” on page 6-5 for more details.

NOTE

Xbuilder’s Action menu contains commands for clearing and reloading segments in the 
Segment Editor/Window. See “Actions menu” on page 8-6 for more information.
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Procedural overview for creating rundowns
The procedure below identifies the high-level steps involved in building rundowns for playing 
out branding and promotional graphics sequences. Subsequent sections (identified by the 
links within the procedure) provide step-by-step instructions for performing each step. 

NOTE

As a preliminary step, verify that the SEGMENTS category is displayed in Xbuilder’s Asset 
Browser (without it you will not be able to populate the rundown). If the SEGMENTS category is 
not displayed, then open the xbuilder.ini file (C:\Program Files\VertigoXmedia\Apps) 
and set the DisplaySegments setting to True.

To create a rundown in Xbuilder:

1. Create a new rundown, or open an existing rundown.

• “Creating a new rundown” on page 7-7

• “Opening an existing rundown” on page 7-8

2. Create new rundown segments for the rundown:

• “Creating a new rundown segment” on page 7-9

• “Adding pages to a rundown segment” on page 7-11

• “Adding scene assets to a rundown segment” on page 7-13

• “Adding clip assets to a rundown segment” on page 7-13

• optional - “Adding a comment row to the rundown segment” on page 7-14

• optional - “Repositioning pages within the rundown segment” on page 7-15

• optional - “Deleting or removing items from a rundown segment” on page 7-16

• “Saving a rundown segment” on page 7-17

3. Add rundown segments to the rundown and edit the rundown:

• “Adding segments to a rundown” on page 7-19

• optional - “Repositioning segments within the rundown” on page 7-21

• optional - “Removing segments from a rundown” on page 7-22

4. Save the rundown

• “Saving a rundown under a different name or category” on page 7-23
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Creating a new rundown
To create a new rundown, you must execute the CREATE NEW RUNDOWN action (described 
below), which immediately replaces whatever is currently in the upper portion of the 
Xbuilder window with a new, empty Rundown/Segment Editor (figure 7-5).

To create a new rundown:

1. Select FILE>NEW RUNDOWN or press CTRL+R. 

The SAVE RUNDOWN dialog box appears (figure 7-4).
\

Figure 7-4. The SAVE RUNDOWN dialog box.

2. In the NAME field enter a new name for the rundown.

3. Enter your name in the AUTHOR field (optional).

4. Enter a short description of the rundown in the DESCRIPTION field (optional).

5. Link the rundown to the RUNDOWNS root category or to sub-categories by selecting the 
check box for each place where you want the rundown to be accessible from.

6. Click OK to save the rundown and exit the dialog box.

The Rundown Editor and Segment Editor appear and are ready to be populated 
(figure 7-5).

Figure 7-5. A newly created rundown with an empty Segment Editor
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Opening an existing rundown
Existing rundowns are stored on the Xmedia Server. You can open existing playlists either 
from the Asset Browser and Template Editor, or from the FILE menu.

To open an existing rundown using the Asset Browser and Template Editor:

1. Select the RUNDOWNS root category in the Asset Browser, and navigate to the 
appropriate category where the rundown is stored.

The rundowns contained in the Asset Browser category are listed in the Template 
Editor.

2. Double-click the desired rundown in the Template Editor.

Or,

Right-click on the rundown in the Template Editor and select the OPEN command from 
the context menu.

The rundown opens in the Rundown Editor and the first segment listed in the rundown 
list is displayed in the Segment Editor.

To open an existing playlist from the File menu:

1. Select FILE>OPEN RUNDOWN. 

The OPEN RUNDOWN dialog box appears.

2. Navigate through the Rundown categories in the right panel until the desired rundown 
is listed in the left panel.

3. Double-click the desired rundown listed in the right panel.

Or, 

Select the rundown and then click OK.

The rundown opens in the Rundown Editor and the first segment listed in the rundown 
list is displayed in the Segment Editor.



Xbuilder User Manual 7-9

Creating and using rundowns and segments 

Creating and using rundown segments
Typically, rundown segments are lists of graphic pages (shared and embedded pages), 
scenes, clips and shared playlists that make up a section of a program. The order in which 
these items are listed in the rundown segment determines their playout order as well.

The following sections provide instructions for creating new rundown segments and 
opening existing rundown segments:

• “Creating a new rundown segment” on page 7-9

• “Configuring the segment table columns” on page 7-11

• “Adding pages to a rundown segment” on page 7-11

• “Adding scene assets to a rundown segment” on page 7-13

• “Adding clip assets to a rundown segment” on page 7-13

• “Adding a comment row to the rundown segment” on page 7-14

• “Repositioning pages within the rundown segment” on page 7-15

• “Deleting or removing items from a rundown segment” on page 7-16

• “Saving a rundown segment” on page 7-17

Creating a new rundown segment

The introduction to rundowns on page 7-1 explains that rundown segments can either be shared 
or embedded. While shared segments can be created and edited in both the Segment Editor 
and the Segment window, embedded segments can only be created in the Segment Editor.

The following instructions guide you through the process of creating new rundown 
segments from either interface.

To create a new shared segment in the Segment window:

1. Select the FILE>NEW SEGMENT command from the Xbuilder toolbar.

The upper portion of the Xbuilder window becomes an empty Segment window (figure 7-6).

Figure 7-6. Stand-alone Segment window

Stand-alone
Segment window
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2. Populate the segment with shared pages and/or embedded pages (templates) from the 
Asset Browser and Template Editor (see “Adding pages to a rundown segment” on 
page 7-11).

3. Click the SAVE button  in the Segment window’s toolbar.

Or,

Select the FILE>SAVE SEGMENT or the FILE>SAVE SEGMENT AS command from the 
Xbuilder menu commands.

The SAVE SEGMENT dialog box appears (figure 7-7).

Figure 7-7. Save the shared segment on the Xmedia Server using the Save Segment dialog box

4. In the NAME field enter a new name for the segment.

5. Enter your name in the AUTHOR field (optional).

6. Enter a short description of the segment in the DESCRIPTION field (optional).

7. Link the segment to the Segments root category or to sub-categories by selecting the 
check box for each place where you want the segment to be accessible from.

8. Click OK to save the segment and exit the dialog box.

To create a new segment (shared or embedded) in the Segment Editor:

1. With a rundown open in the Rundown window, click the NEW SEGMENT button  in 
the Segment Editor’s toolbar.

A new segment is added to the rundown window below the initial segment listed and 
the Segment Editor becomes empty and is ready to be populated.
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Configuring the segment table columns
The segment table’s columns display information about each page included in the rundown 
segment. Using the TOOLS>CONFIGURE PLAYLIST COLUMNS command, you can determine 
which columns are displayed or hidden in the segment table. You can also determine the 
order in which the columns appear in the table. 

Since the instructions for configuring the segment table’s columns are identical to those for 
the playlist columns, please refer to “Configuring the Playlist table columns” on page 6-11.

Adding pages to a rundown segment
The method that you will use to add a page to a rundown segment will depend upon whether 
you want the page to be embedded or shared. 

The following sections provide instructions for adding embedded pages, shared pages, and 
the pages of a playlist to a rundown segment:

• “Adding an embedded page to a rundown segment” on page 7-11

• “Adding a shared page to a rundown segment” on page 7-12

• “Adding the pages of a playlist to a rundown segment” on page 7-13

NOTE

Do not use the FILE>INSERT SEGMENT or FILE>APPEND SEGMENT commands to add the 
pages contained in one segment to another segment, as this creates a playlist segment in 
the receiving segment. The obstacle is that rundown segments that contain playlist 
segments cannot be added to rundowns.

Adding an embedded page to a rundown segment
The following instructions describe the two (2) ways that you can add an embedded page 
to a rundown segment.

To add an embedded page to a rundown segment using the Insert New Page button:

1. With the segment open in either the Segment Editor or the Segment Window, select 
the INSERT NEW PAGE button  in the Segment’s toolbar.

The SELECT A TEMPLATE FOR THE NEW GRAPHIC dialog box appears.

2. Navigate and select the template that you would like to the new page to be based upon, 
then click OK.

The template opens in Xbuilder’s Template Editor.

3. Make the appropriate edits to the template’s variable fields, then click the INSERT IN 
PLAYLIST AND CLOSE button  in the Template Editor’s toolbar.

The template is added to the segment editor/window as an embedded page.

NOTE

To save the new embedded page as a shared page, select the page in the Segment 
Editor/window and click either the SAVE CURRENT SEGMENT AS button  or the 
FILE>SAVE SEGMENT AS command (see “Saving a rundown segment” on page 7-17).
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To add an embedded page to a rundown segment using templates from the Asset 
Browser:

1. Open the rundown segment in either the Segment Editor or the Segment Window.

2. Navigate and select a template from the Asset Browser/Template Editor.

3. Perform one of the following:

• Drag the template from the Template Editor and drop it into the segment. Then 
double-click the page’s name in the Segment table. The page opens in the 
Template Editor. Make the appropriate edits to the template’s variable fields, 
then click the COMMIT AND CLOSE button  in the Template Editor’s toolbar 
(or drag the X-logo icon into the segment).

Or,

• Double-click the template in the Template Editor. The page opens in the 
Template Editor. Make the appropriate edits to the template’s variable fields, 
then click the INSERT IN PLAYLIST AND START A NEW PAGE button  in the 
Template Editor’s toolbar (or drag the X-logo icon into the segment).

NOTE

To save the new embedded page as a shared page, select the page in the Segment 
Editor/window and click either the SAVE CURRENT SEGMENT AS button  or the 
FILE>SAVE SEGMENT AS command (see “Saving a rundown segment” on page 7-17).

Adding a shared page to a rundown segment

To add a shared page to a rundown segment using pages from the Asset Browser:

1. Open the rundown segment in either the Segment Editor or the Segment Window.

2. Navigate and select a page from the Asset Browser/Template Editor.

3. Perform one of the following:

• Drag the page from the Template Editor and drop it into the segment. Then 
double-click the page’s name in the Segment table. The page opens in the 
Template Editor. Make the appropriate edits to the page’s variable fields, then 
click the SAVE PAGE AND CLOSE button  in the Template Editor’s toolbar 
(or drag the X-logo icon into the segment).

Or,

• Double-click the page in the Template Editor. The page opens in the Template 
Editor. Make the appropriate edits to the page’s variable fields, then click the 
SAVE PAGE, INSERT IN PLAYLIST button  in the Template Editor’s toolbar 
(or drag the X-logo icon into the segment).
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Adding the pages of a playlist to a rundown segment

If the series of pages that you want to add to the rundown segment already exist within a 
playlist, you can add the playlist to the rundown segment and the pages will automatically 
become a part of the segment.

NOTE

The playlist that is to be added to the rundown segment must only contain pages. The 
playlist will be rejected if it contains playlist segments or clips.

To add the pages of a playlist to a rundown segment:

1. Open the rundown segment in either the Segment Editor or the Segment Window.

2. Navigate and select a playlist from the Asset Browser/Template Editor.

3. Drag the playlist from the Asset Browser/Template Editor and drop it into the Segment.

The pages that were contained in the playlist are automatically listed in the rundown 
segment.

Adding scene assets to a rundown segment

To add a scene asset to a rundown segment:

1. Open the rundown segment in either the Segment Editor or the Segment Window.

2. Navigate and select a scene asset from the Asset Browser/Template Editor.

3. Perform one of the following:

• Drag the asset from the Template Editor and drop it into the segment. 

Or,

• Open the scene in the Template Editor. Make the appropriate edits to the 
scene’s variable fields, then click the SAVE SCENE, INSERT IN PLAYLIST button 

 in the Template Editor’s toolbar (or drag the X-logo icon into the 
segment).

Adding clip assets to a rundown segment

To add a clip asset to a rundown segment:

1. Open the rundown segment in either the Segment Editor or the Segment Window.

2. Navigate and select a clip asset from the Asset Browser/Template Editor.

3. Drag the asset from the Template Editor and drop it into the segment. 

Clip assets are added to segments as primary events and highlighted in green (below).
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Adding a comment row to the rundown segment

Annotating your segment by adding comments often benefits the person operating the 
rundown. Your comments should be concise, yet identify the purpose or behavior of 
elements in your segment.

To add comments to the segment:

1. Select the segment row where you want the comment to be inserted (the comment will 
be inserted above the selected row).

2. Right-click on the row and select the ADD COMMENT command from the context menu 
that appears (figure 7-8). 

The comment row is added above the selected row with the text ready for editing.

Figure 7-8. Use the ADD COMMENT command to insert an annotation into the segment

3. Type the text for the comment and press ENTER. 

To edit the text of a comment row that is already inserted into the segment:

1. Select the comment row who’s text is to be edited.

2. Right-click on the row and select the EDIT CELL command from the context menu that 
appears (figure 7-9). The comment row text becomes ready for editing.

Figure 7-9. Use the EDIT CELL command to change the text in a segment annotation

3. Type the new text for the comment and press ENTER.
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Repositioning pages within the rundown segment

The order in which pages are listed in the segment determines their playout order as well. 
As such, after adding the pages to the segment, you may need to reposition pages within 
the segment to reflect the desired playout order.

To reposition a page within a segment:

1. Select the page that you want to move to a new location.

2. Click and drag the selected page into the desired segment row. 

As you drag, a insert line (red line by default) extends across the table, which indicates 
where the item will be placed (figure 7-10). 

3. Release the mouse button to drop the item in its new location.

Figure 7-10. Drag and drop the page to the desired row location
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Deleting or removing items from a rundown segment

The following instructions describe how to remove individual pages, scenes, clip and 
comments from the rundown segment, as well as how to remove all of the segment’s 
contents in one action.

NOTE

If the page that is to be deleted is a saved, shared asset, deleting the page from the 
segment does not remove the asset from the system, only from the segment. However, 
embedded pages and comments that were added to the segment will be completely deleted 
from the system.

To delete an individual item (page, scene, clip or comment) from the segment:

1. Select the item that you would like to delete from the segment.

2. Right-click on the item’s row and select the DELETE command from the context menu.

Or,

Press the DELETE key on your keyboard.

3. If Xbuilder’s CONFIRM PAGE DELETION property (TOOLS>SETTINGS>AUTOMATION) is 
enabled, the CONFIRM DELETE dialog box appears. Select YES and the item is 
immediately deleted from the segment, or select NO to cancel the delete action.

If however Xbuilder’s CONFIRM PAGE DELETION property 
(TOOLS>SETTINGS>AUTOMATION) is disabled, then the item is immediately deleted from 
the segment.

To delete a consecutive grouping of items from the playlist:

1. Select the first item that you would like to delete from the segment.

2. While holding down the SHIFT key, select the last item that you would like to delete from 
the segment.

The first, last, and all items between these two become selected forming the group of 
items to be deleted from the segment.

3. Right-click within the grouping and select the DELETE command from the context menu.

Or,

Press the DELETE key on your keyboard.
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4. If Xbuilder’s CONFIRM PAGE DELETION property (TOOLS>SETTINGS>AUTOMATION) is 
enabled, the CONFIRM DELETE dialog box appears. Select YES and the items are 
immediately deleted from the segment, or select NO to cancel the delete action.

If however Xbuilder’s CONFIRM PAGE DELETION property is disabled, then the items are 
immediately deleted from the segment.

To delete the entire contents of the segment in one action:

1. Select the ACTIONS>CLEAR PLAYLIST command from Xbuilder’s menu commands.

Or,

Press F8.

2. If Xbuilder’s CONFIRM PLAYLIST CLEAR property (TOOLS>SETTINGS>AUTOMATION) is 
enabled, the CLEAR SEGMENT dialog box appears. Select YES and the items in the 
segment are immediately deleted and the segment is left empty. Or, select NO to cancel 
the clear segment action.

If however Xbuilder’s CONFIRM PLAYLIST CLEAR property is disabled, then the segment 
items are immediately removed from the segment, leaving an empty segment.

Saving a rundown segment

After building or editing the rundown segment, you must save the segment to retain its 
current pages and settings. Saving the segment not only makes edits permanent, but it also 
offers you an opportunity to save embedded segments as shared segments.

NOTE

An asterisks next to the segment’s name indicates that edits have been made to the 
segment, but have not yet been saved.

Use the SAVE CURRENT SEGMENT button  to save the rundown in its current form. In other 
words, an embedded segment is saved as an embedded segment, and a shared segment 
is saved as a shared segment. 

Use the SAVE CURRENT SEGMENT AS button  to open the SAVE SEGMENT dialog box, 
which allows you to save an embedded segment as a shared segment, or to save a shared 
segment under a different name or in a different category.

NOTE

When the rundown segment is open in the Segment window, the FILE>SAVE SEGMENT and 
FILE>SAVE SEGMENT AS commands perform the equivalent actions as the buttons 
described above.
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Opening an existing rundown segment
There are three (3) ways to open an existing rundown segment:

• Opening a shared segment from the Asset Browser. Double-click the segment’s name 
in the Template Editor opens the segment in the Segment Window.

• With the Segment Window already open, select the FILE>OPEN SEGMENT command. 
The OPEN SEGMENT dialog box appears and allows you to select the shared segment 
to be opened. Click OK and the segment automatically appears in the Segment 
Window.

• With a rundown open in the Rundown Editor, double-click a segment in the rundown 
list and the segment opens in the Segment Editor.

Regardless of which way you choose to open the segment, once the rundown segment is 
displayed in the Segment Editor/Window, you can:

• edit the segment by opening, adding, removing, or repositioning the pages, scenes and 
clips that belong to the segment

• add comments to the segment

• open and edit the pages, scenes and clips belonging to the segment

• save any changes to the segment, or save it under a different name or category
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Adding segments to a rundown
The RUNDOWN EDITOR contains the list of segments that make up the content and playout 
order of the program. Populating the Rundown Editor involves adding segments to the 
rundown list. Selecting a segment listed in the rundown list displays the contents of the 
segments in the SEGMENT EDITOR (next to the Rundown Editor).

The following sections provide instructions for adding segments to a rundown:

• “Adding the first segment to a new rundown” on page 7-19

• “Adding additional segments to a rundown” on page 7-20

NOTE

The FILE>NEW SEGMENT command does not add a new segment to a rundown, rather it 
creates a new shared segment using the Segment Window. See “Creating a new rundown 
segment” on page 7-9 for more information.

Adding the first segment to a new rundown

Figure 7-11 shows that when a new rundown is created, the Segment Editor’s status reads 
NO SEGMENT LOADED, which means that the current rundown does not yet contain any segments.

Figure 7-11. A newly created rundown does not contain any segments

To add a first segment to a rundown:

1. Click the CREATE NEW SEGMENT button  in the Segment Editor’s toolbar.

A new segment is added to the Rundown Editor’s list with NEW SEGMENT as its default 
name.

2. The segments default name is highlighted (white) and can be edited immediately by 
typing the new name (figure 7-12). If the default name is no longer highlighted, right-
click on the default name and use the RENAME command to provide a new name for 
the segment.

Figure 7-12. Replace the new segment’s default name immediately

No segment loaded.
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The segment’s name is displayed in the Segment Editor’s status line and you can now 
populate the segment with pages (see “Adding pages to a rundown segment” on page 
7-11).

NOTE

When a new rundown is created, the CREATE NEW SEGMENT button does not appear in the 
Segment Editor’s toolbar if the Asset Browser contains the Segments root category. To 
display or hide the Segments root category, edit the root category’s display setting 
(i.e. DisplaySegments=False) in the xbuilder.ini file.

Adding additional segments to a rundown

When an existing rundown is opened, the RUNDOWN EDITOR lists the segments in the order 
in which they will be played out. Meanwhile, the SEGMENT EDITOR (next to the Rundown 
Editor) displays the pages that belong to the segment that is currently selected in the 
rundown list.

To add additional segments to a rundown:

1. Select the segment in the Rundown Editor where the new segment will be placed (the 
new segment is placed above the selected segment).

2. Perform one of the following:

• Click the CREATE NEW SEGMENT button  in the Segment Editor’s toolbar.
A new segment is added to the Rundown Editor’s list with NEW SEGMENT as 
its default name.

Or,

• Drag an existing shared segment from the Asset Browser/Template Editor 
and drop it into the desired location in the Rundown Editor’s segment list.

Or,

• Drag an existing shared page or template (creates an embedded page) from 
the Asset Browser/Template Editor and drop it into the desired location in the 
Rundown Editor’s segment list. The segment that is created contains the 
shared or embedded page as the first item in the segment.

The segment’s name is displayed in the Segment Editor’s status line and you can now 
populate the segment with pages (see “Adding pages to a rundown segment” on page 
7-11).

NOTE

When a new rundown is created, the CREATE NEW SEGMENT button does not appear in the 
Segment Editor’s toolbar if the Asset Browser contains the Segments root category. To 
display or hide the Segments root category, edit the root category’s display setting (i.e. 
DisplaySegments=False) in the xbuilder.ini file.
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Repositioning segments within the rundown
The order in which segments are listed in the Rundown Editor determines the playout order 
as well. As such, after adding the segments to the rundown, you may need to reposition 
segment within the rundown to reflect the desired playout order.

To reposition a segment within a rundown:

1. Select the segment that you want to move to a new location.

2. Drag the selected segment into the desired rundown row. 

As you drag, a insert line (red line by default) extends across the list, which indicates 
where the segment will be placed (figure 7-13). 

3. Release the mouse button to drop the item in its new location.

Figure 7-13. Reordering segments within the rundown

NOTE

Repositioning the segments in a rundown automatically saves the new order immediately, 
so that if the rundown is playing, then the changes are immediately implemented.
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Removing segments from a rundown
The RUNDOWN EDITOR contains the list of segments that make up the content and playout 
order of the program. If the rundown list contains a segment that is no longer needed, you 
can remove it from the rundown using the DELETE command.

NOTE

If the segment is an embedded segment, then it is deleted from the system permanently. If, 
however, the segment is saved as a shared segment, then it will only be removed from the 
rundown, not the system. See “Saving a rundown segment” on page 7-17 for more 
information about embedded and shared segments.

To remove a segment from a rundown:

1. Right-click on the segment in the Rundown Editor and select the DELETE command 
from the context menu.

Or, 

Select the segment in the Rundown Editor and press the DELETE key on your keyboard.

2. If Xbuilder’s CONFIRM PAGE DELETION property (TOOLS>SETTINGS>AUTOMATION) is 
enabled, the CONFIRM DELETE dialog box appears. Select YES and the segment is 
immediately deleted from the Rundown Editor. Or, select NO to cancel the delete 
segment action.

If however Xbuilder’s CONFIRM PAGE DELETION property is disabled, then the segment 
is immediately removed from the Rundown Editor.



Xbuilder User Manual 7-23

Creating and using rundowns and segments 

Saving a rundown under a different name or category
Although the rundown was saved to the Xmedia Server when it was created (see “Creating 
a new rundown” on page 7-7), you can use the TEMPLATE EDITOR RUNDOWN AS command 
to save the currently open rundown under a different name or category.

Selecting the FILE>SAVE RUNDOWN AS command, opens the SAVE RUNDOWN dialog box 
(figure 7-14), which allows you to specify a new name for the currently open rundown and/or 
save the rundown within a sub-category of the RUNDOWNS root category in the Asset 
Browser.

Figure 7-14. The Save Rundown dialog box
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Deleting a rundown from the system
All saved rundowns are stored on the Xmedia Server and are accessed from within the 
RUNDOWNS root category in the Asset Browser. When the RUNDOWNS category (and 
subcategories) are selected in the Asset Browser, the individual rundowns are listed in the 
Template Editor.

If a rundown is no longer needed, you can permanently remove it from the system by:

1. Right-click on the rundown listed in the Template Editor and select the DELETE 
command from the context menu.

Or,

Select the rundown listed in the Template Editor and press the DELETE key on your 
keyboard.

2. The DELETE dialog box appears and asks you to confirm whether you want to delete 
the rundown. Click YES to delete the rundown and the rundown is immediately deleted 
from the system. Click NO to cancel the delete action.
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8 APPENDIX A - QUICK REFERENCE TO 
XBUILDER’S MENUS & TOOLBARS

The following sections provide a quick reference to the menu commands, toolbars, and 
properties associated with various parts of Xbuilder’s user interface:

• “Xbuilder’s menu commands” on page 8-2

• “Playlist Editor’s toolbar” on page 8-9

• “Template Editor’s toolbar & properties” on page 8-11

• “Segment Editor toolbar” on page 8-17

NOTE

See “Overview of Xbuilder’s user interface” on page 2-4 for a quick orientation to the entire 
Xbuilder user interface. All user interface features and components are described in full 
detail throughout this document in their applicable tasks and instructions.

Xbuilder’s 
menu commands

Playlist Editor

Template Editor
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Xbuilder’s menu commands
Many of Xbuilder’s key features are thematically organized within the menu bar command 
structure at the top of the main interface window.

The following sections provide functional definitions of the Xbuilder menu commands:

• “File menu” on page 8-2

• “View menu” on page 8-5

• “Actions menu” on page 8-6

• “Tools menu” on page 8-7

• “Timeline menu” on page 8-7

• “Help menu” on page 8-8

File menu

The FILE menu contains commands that are related to opening, inserting, appending, and 
saving playlists, segments, and rundowns. 

Note that the name displayed for the following commands, OPEN, APPEND, INSERT, SAVE, 
and SAVE AS, depends upon whether a playlist, rundown, segment window is active (see 
figure 8-1). 

Figure 8-1. Some File menu commands names are dynamic

When the Playlist Editor is active When the Segment window is active
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Each of the FILE menu commands are described in the following table:

NEW PLAYLIST Opens a new, empty playlist.

Alternative access:

• Keyboard shortcut: CTRL+N

•  NEW PLAYLIST button in the Playlist Editor

NEW RUNDOWN Opens a new, empty rundown.

Alternative access:

• Keyboard shortcut: CTRL+R

NEW SEGMENT Opens a new, empty segment.

Alternative access:

• Keyboard shortcut: CTRL+T

•  CREATE NEW SEGMENT button in the Segment window

NEW TIMELINE Opens a new, empty timeline.

This command is disabled unless a seed file is specified in Xbuilder’s 
GENERAL setting’s TIMELINE SEED field in.

Alternative access:

•  NEW TIMELINE button in the Timeline window

OPEN

[OPEN PLAYLIST]
[OPEN SEGMENT]
[OPEN RUNDOWN]

Depending the active window in Xbuilder, this command displays a dialog 
box that lets you select an existing playlist, segment, or rundown to open.

Alternative access:

• Keyboard shortcut: CTRL+O

•  OPEN EXISTING PLAYLIST button in the Playlist Editor

APPEND

[APPEND PLAYLIST]
[APPEND SEGMENT]

Depending what is already open in Xbuilder, this command displays a 
dialog box that lets you select a playlist or segment to add to the end of the 
current playlist.

Alternative access:

• Keyboard shortcut: CTRL+P

INSERT

[INSERT PLAYLIST]
[INSERT SEGMENT]

Displays a dialog box that lets you select a playlist or segment to insert 
above the currently selected row in the current playlist/segment.

Alternative access:

• Keyboard shortcut: CTRL+I
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SAVE

[SAVE PLAYLIST]
[SAVE SEGMENT]

Saves the currently opened playlist, segment, or rundown. If the item is new 
and has not yet been saved, a dialog box displays that lets you set specific 
data related to the asset (i.e. name, author, description...etc.).

Alternative access:

• Keyboard shortcut: CTRL+S

•  SAVE CURRENT PLAYLIST button in the Playlist Editor

•  SAVE CURRENT SEGMENT button in the Segment window

SAVE AS

[SAVE PLAYLIST AS]
[SAVE SEGMENT AS]
[SAVE RUNDOWN AS]

Opens a dialog box that allows you to save the playlist, segment, or 
rundown using a new name.

Alternative access:

• Keyboard shortcut: CTRL+S

•  SAVE CURRENT PLAYLIST AS button in the Playlist Editor

•  SAVE CURRENT SEGMENT AS button in the Segment window

SAVE AS SHARED PAGE Saves the open page or template as a page asset on the Xmedia Server, 
so that it is available to be used in other playlists. See “Creating an 
individual shared page from a template” on page 3-3 for more information.

Alternative access:

• Keyboard shortcut: CTRL+H

EXIT Closes Xbuilder.

Alternative access:

• Keyboard shortcut: CTRL+Q

•  CLOSE button in the top-right corner of the Xbuilder window
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View menu

The VIEW menu contains commands that are related to displaying or hiding browsers and 
tools that are used by, or within, the Xbuilder interface. The following table describes the 
functionality of the View menu’s commands.

OPEN MESSAGE LOG When selected, this command displays the message log dialog box, which 
records the processes and errors that occur during your Xbuilder session. 
When cleared, this command hides the log.

Alternative access:

• Keyboard shortcut: CTRL+M

ASSET BROWSER Displays or hides the ASSET BROWSER. The Asset Browser is a collapsible 
panel on the lower-left side of the Xbuilder interface that allows you to view 
and access assets according to their type.

Alternative access:
• Keyboard shortcut: CTRL+A
• Click the handle along the lower-left portion of the Xbuilder interface.

OPEN LOG FILE When selected, this command opens the current log file in Notepad from: 
C:\ProgramData\VertigoXmedia\Logs. The log file stores the processes 
and errors that occurred during your Xbuilder session and is useful when 
debugging.

SHOW/HIDE PANEL Displays or hides the lower portion of the Template Editor, which displays 
the control objects of an open control panel.

Alternative access:
• Keyboard shortcut: CTRL+L

FAVORITES BROWSER Displays or hides the FAVORITES BROWSER, which is a collapsible panel on 
the lower-right side of the Xbuilder interface that allows you to view and 
storage frequently used templates and pages. 

Alternative access:
• Keyboard shortcut: CTRL+U
• Click the handle along the lower-right portion of the Xbuilder interface.

PROXY VIEW Determines the format by which the Template Editor displays assets from 
the Asset Browser. The two available formats are: thumbnail (proxy) 
images, or as detailed lists.

Alternative access:

• Keyboard shortcut: CTRL+W

DISPLAY FRAMES Only available when a timeline is active.

Allows you to set the timeline’s top ruler’s units as frames or time code units.
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Actions menu

The ACTIONS menu contains commands that allow you to control or perform tasks related 
to your playlists, segments, or devices. Many of these commands are also available within 
the appropriate windows as buttons, or as key command shortcuts.

CLEAR

[CLEAR PLAYLIST]
[CLEAR SEGMENT]

Deletes all items in the playlist or segment.

Alternative access:

• Keyboard shortcut: F8

RELOAD

[RELOAD PLAYLIST]
[RELOAD SEGMENT]

Reloads the last saved version of the playlist or segment.

Alternative access:

• Keyboard shortcut: F5

•  RELOAD PLAYLIST button in the Playlist Editor

•  RELOAD SEGMENT button in the Segment window

INGEST PLAYLIST Opens the IMPORT PLAYLIST LOG FILE dialog box, which allows you to 
import playlist log files (.log) into Xbuilder.

Alternative access:

• Keyboard shortcut: F10

CREATE WORK ORDER Opens the WORK ORDER dialog box, which allows you to create a new work 
order. The work order system requires users to login using a user name and 
password. User names and passwords are registered and stored on the 
Xmedia Server using the Xmedia Server’s properties panel.

Alternative access:

• Keyboard shortcut: F11

CLEAR DEVICE Sends a clear command to the device connected to Xbuilder causing the 
device’s display to immediately stop displaying its contents.

OPEN MERGE LIST The OPEN MERGE LIST command allows you to create multiple pages and/or 
scenes from a single Merge List file (spreadsheet or XML file). Acting as the 
data source, the Merge List file provides Xbuilder with the information it 
needs to create new instances of pages/scenes from existing template and 
scene assets.

OPEN MAKELIST As the gateway to the Vertigo Quality Control (QC) workflow, the OPEN 
MAKELIST command allows you to open a Make List file, which creates a 
playlist element for each of the assets (pages) that were created by the 
After Effects Plug-in’s export. You can then preview, approve or reject the 
new graphics. See “Quality Control: Previewing and validating graphics in 
Xbuilder” on page 5-12 for more information.
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Tools menu

The TOOLS menu contains commands that allow you to specify some of settings that affect 
the aesthetic and behavioral properties of Xbuilder. It also allows you to configure Xbuilder 
to interact with other devices and applications. The following table describes the 
functionality of the Tools menu commands.

Timeline menu

The TIMELINE menu only appears when the Timeline Editor is open in the Xbuilder window.

OPEN AIRLIST As the gateway to the Vertigo Media Check (MC) workflow, the OPEN 
AIRLIST command allows Master Control to quickly verify that all of the 
assets that were validated (approved) during the QC workflow have been 
published to the target playout devices. See “Media Check: Graphics 
publish verification” on page 5-14 for more information.

SETTINGS Displays the SETTINGS dialog box, which is used to establish the aesthetic and 
behavior of many of the Xbuilder features. See “Configuring Xbuilder’s settings” 
on page 2-6 for more information.

CONFIGURE 
PLAYLIST COLUMNS

Displays the COLUMN LAYOUT dialog box. This allows you to determine what kind 
of information will be displayed in the Playlist and Segment windows for each item. 
See “Configuring the Playlist table columns” on page 6-11 and “Configuring the 
segment table columns” on page 7-11 for more information.

PLUGINS Opens the PLUGIN MANAGER, which is used for registering or de-registering 
plugins that support or enhance Xbuilder. 

DEVICE MANAGER Displays the DEVICE CONFIGURATION dialog box, which allows you to define and 
add new output devices to the Device Manager. Once devices are added to the 
Device Manager, you can connect a device to Xbuilder to be used for previewing 
and/or verify if each playlist element has been published on the device. See 
“Adding and configuring a Preview device” on page 2-7 for more information.

TIMELINE SEEDS Displays the TIMELINE SEED dialog box, which allows you to add/remove and 
specify the seed files that are used as the basis for building auto promo timelines 
in the Timeline Editor.
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Help menu

The HELP menu contains commands that provide Xbuilder product information, like 
licensing and software version identification, as well as access to the License Manager for 
installing the required applications license. The following table describes the commands 
available within Xbuilder’s Help menu.

FADE This command is only enabled when the timeline’s seed file contains a 
Fader channel. Selecting this command displays the TIMELINE FADE dialog 
box, which allows you set the duration of the automatic fade-in and fade-
out of the timeline. See for more information.

RENDER TO FILE This command allows you to render and save a copy of the entire auto 
promo on either the VertigoXG or the Software CG devices. 

BATCH RENDER TO FILE Not yet documented.

SNAPSHOT This command allows you to extract a single frame of an auto promo 
timeline and save it to a file as an image file (.tga).

ABOUT Displays the product information regarding what the version of Xbuilder and Xmedia 
Suite you are using.

LICENSE Opens the LICENSE MANAGER dialog box, which allows you to install and view the 
required application licenses for Xbuilder. See the Vertigo Suite Release Notes for 
specific instructions on how to acquire and install licenses for Xbuilder.
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Playlist Editor’s toolbar
The toolbar along the top-left side of the Playlist Editor contains a series of buttons that allow 
you to populate the playlist and perform other basic actions on the existing playlist. See “An 
overview of the Playlist Editor” on page 6-2 for more information.

The following table provides a functional description of each button on the playlist toolbar:

 

CREATE NEW PLAYLIST

Create and displays a new, empty playlist.

Alternative access:

• Menu command: FILE>NEW PLAYLIST

• Keyboard shortcut: CTRL+N

 

OPEN EXISTING PLAYLIST

Displays a dialog box for selecting and opening an existing playlist asset.

Alternative access:

• Menu command: FILE>OPEN PLAYLIST

• Keyboard shortcut: CTRL+O

 

SAVE CURRENT PLAYLIST

Saves the current playlist. If the playlist is new and has not yet been saved, 
a dialog box appears and lets you set specific data related to the playlist.

Alternative access:

• Menu command: FILE>SAVE PLAYLIST

• Keyboard shortcut: CTRL+S

 

SAVE CURRENT PLAYLIST AS

Saves the current playlist under a different name.

Alternative access:

• Menu command: FILE>SAVE PLAYLIST AS

 

RELOAD

Reloads the most recently saved version of the playlist.

Alternative access:

• Menu command: ACTIONS>RELOAD PLAYLIST

• Keyboard shortcut: F5

 

INSERT NEW PAGE

Opens the SELECT A TEMPLATE FOR THE NEW GRAPHIC dialog box, which 
allows you to insert a new page into the playlist.
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VERIFY PLAYLIST

Executes a manual playlist verification to see if the items in the playlist have 
been properly published to the devices selected in the Device for Verify 
drop-down list. 

 

APPROVE ALL ITEMS IN MERGELIST

This button only appears when the playlist open in the Playlist Editor was 
created from a Merge List.

Approves all of the items (pages & scenes) in the playlist, moves the assets 
to the appropriate categories, and changes the item’s status in the playlist 
to APPROVED. See “Approving or rejecting new pages and scenes created 
from a Merge List” on page 3-8 for more information.

 

RENDER ALL ITEMS IN PLAYLIST

This button only appears when the playlist open in the Playlist Editor was 
created from a Merge List.

When a Merge List is used to create pages and scenes (see page 3-13), all 
of the resulting pages and scenes can be rendered and saved as individual 
video clip files using the Playlist Editor’s RENDER ALL ITEMS IN PLAYLIST 
button. See “Batch-rendering of pages and/or scenes to a file” on page 4-7 
for more information.
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Template Editor’s toolbar & properties
Xbuilder’s Template Editor is located in the bottom portion of the Xbuilder interface and is 
used to display and edit pages, templates, and/or scene assets. When a template or page 
asset is opened in Xbuilder, the control-side of the project (Template+Scene) is displayed 
in the Template Editor allowing you to make edits to the content and create new pages. 
Logically, opening a standalone scene asset displays the actual scene allowing you to also 
make changes to its content. 

Figure 8-2. Template Editor features and components

The Template Editor’s toolbar items and properties change slightly depending on the type 
of asset that it is currently open in the Template Editor. The following sections identify and 
describe each of the possible toolbar buttons, properties, icons and fields that may appear 
in the Template Editor.

• “Template Editor’s toolbar buttons” on page 8-12

• “Template Editor’s properties” on page 8-15

• “X-icon” on page 8-15

• “Asset name (Template or Scene)” on page 8-15

• “Shared Page, Embedded Page and Scene icons” on page 8-16

Template Editor’s
canvas

Template Editor’s
toolbar

Template Editor’s
properties

X-icon, asset name
and page/scene icons
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Template Editor’s toolbar buttons

Depending upon the type of asset and how it was opened, the Template Editor’s toolbar 
contains the following buttons:

 

SAVE PAGE or SAVE SCENE

This button is only available if the current page (shared page) or scene 
asset was opened from the Asset Browser.

Saves any edits that have been made to the current page (shared page) or 
scene.

 

SAVE PAGE, AND CLOSE

This button is only available if the current page (shared page) or scene 
asset was opened from within the playlist.

Saves any edits that have been made to the current page or scene and 
closes the page/scene so that it is no longer displayed in the Template 
Editor.

 

SAVE PAGE AS or SAVE SCENE AS

This button is only available if the current page (shared page) or scene 
asset was opened from the Asset Browser.

Saves any edits that have been made to the current page or scene under 
a different name and allows you to store it within other Pages or Scenes 
categories in the Asset Browser.

 

INSERT IN PLAYLIST AND START NEW PAGE

This button is only available if the current page (embedded page) was 
opened from within the playlist.

Saves any edits that have been made to the current shared page and adds 
it to the playlist currently opened in the Playlist Editor. Where within the 
playlist the page is added depends on whether the ENABLE INSERT PAGE 
AFTER SELECTED button is enabled or disabled.

 

COMMIT AND CLOSE

This button is only available if the current page (embedded page) was 
opened from within the playlist.

Updates the page in the playlist with any edits that have been made and 
closes the page so that it is no longer displayed in the Template Editor.



Xbuilder User Manual 8-13

Appendix A - Quick reference to Xbuilder’s menus & toolbars 

 

NEW PAGE

This button is only available if the current page (shared page) was opened 
from the Asset Browser.

Creates a new page by resetting the variable fields back to their original 
template defaults. Note that the new page is not actually created until you 
save it as a shared page, or add it to the playlist as an embedded page.

 

SAVE PAGE, INSERT IN PLAYLIST or SAVE SCENE, INSERT IN PLAYLIST

This button is only available if the current page (shared page) or scene was 
opened from the Asset Browser.

Saves any edits that have been made to the current shared page and adds 
it to the playlist currently opened in the Playlist Editor. Where within the 
playlist the page is added depends on whether the ENABLE INSERT PAGE 
AFTER SELECTED button is enabled or disabled.

 

ENABLE INSERT PAGE AFTER SELECTED or ENABLE INSERT SCENE AFTER 
SELECTED 

This button is only available if the current page (shared page or embedded) 
or scene was opened from the Asset Browser.

When enabled (orange rather than blue), and the SAVE PAGE, INSERT IN 
PLAYLIST button is used, the page will be inserted into the playlist below the 
currently selected row. When disabled, the page will be added to the last 
row in the playlist.

 

CREATE NEW WORKORDER

This button is available if the current page (shared page or embedded) was 
opened from either the Asset Browser or from within the playlist. However, 
it is not available when a scene asset is open.

Opens the WORK ORDER dialog box, which allows you to create a new work 
order for the page. The work order system requires users to login using a 
user name and password. User names and passwords are registered and 
stored on the Xmedia Server using the Xmedia Server’s properties panel. 

 

APPROVE AND NEXT

This button is available if the current page or scene was opened from the 
playlist created by the Merge List or Make List file.

As part of the Merge List and QC workflow, you can perform a quality 
control verification of the pages and scene created from the Merge List / 
Make List. See page 3-8 and page 5-12 for more information.
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REJECT AND NEXT

This button is available if the current page or scene was opened from the 
playlist created by the Merge List or Make List file.

As part of the Merge List and QC workflow, you can perform a quality 
control verification of the pages and scene created from the Merge List / 
Make List. See page 3-8 and page 5-12 for more information. 

 

NEXT MERGE LIST ITEM

This button is available if the current page or scene was opened from the 
playlist created by the Merge List or Make List file.

This button allows you to move to the next item (skip) in a playlist created 
by the Merge List / Make List without changing its Status.

 

PREVIEW PAGE or PREVIEW SCENE

This button is available to all pages, templates and scenes opened in the 
Template Editor.

Allows you to view the playout of the resulting template, page, or scene on 
the configured preview device (Software CG), including the playout of its 
video, audio, and animation elements. 

 

RENDER PAGE TO FILE or RENDER SCENE TO FILE

This button is available to all pages, templates and scenes opened in the 
Template Editor.

If a template, page or scene contains clips, audio files, and/or cel 
animations, then the RENDER TO FILE command in the Template Editor’s 
toolbar allows you to render and save the template/page as a video file. 

 

TAKE SNAPSHOT OF PAGE or TAKE SNAPSHOT OF SCENE

This button is available to all pages, templates and scenes opened in the 
Template Editor.

The TAKE SNAPSHOT OF PAGE/SCENE command  in the Template 
Editor’s toolbar allows you to render and save (as an image file) a single 
frame of the scene’s playout. This is particularly useful when the template, 
page or scene that is open in Xbuilder’s Template Editor contains clips 
and/or cel animations, as you can specify the exact frame during playout to 
capture. 
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Template Editor’s properties

The following page properties can be set from within the Template Editor:

X-icon

The X-ICON  appears in the upper portion of the Template Editor when a template, page 
or scene was opened from the Asset Browser. Once any edits have been saved, dragging 
the icon from the Template Editor to the playlist allows you to add the page or scene to a 
playlist that is open in the Playlist Editor.

Asset name (Template or Scene)

The name of the template or scene that the shared page or scene is based upon is 
displayed in the upper-right portion of the Template Editor. This is information is practical if 
you want to make changes to the page/scene that goes beyond editing the variable fields, 
such as changing the layout or formatting. These types of changes require editing the 
template in Xstudio.

Even though shared pages are assets saved in the Xmedia Server, all pages are built from 
templates and therefore inherit the properties and formatting settings of the template. As 
such, only the variable fields from the template can be changed on the page in Xbuilder. The 
implication of being based on a template is that any saved changes to the template in Xstudio 
will automatically be transmitted to all of the pages that were created from that template.

RECALL ID This property is only available to pages (shared pages) and scene assets 
opened in the Template Editor.

Allows you to specify a unique identifier for the page or scene. The Recall ID 
can later be used to instantly call up the page asset in the Vertigo Suite’s 
playout application, Xplay.

NAME This property is only available to templates (embedded pages) opened in the 
Template Editor.

The default name of the embedded page will be identical to the name of the 
template until you type a new name in this field and press either the INSERT IN 
PLAYLIST AND START NEW PAGE button or the COMMIT AND CLOSE button in the 
Template Editor toolbar.

DESCRIPTION Allows you to provide a short textual description of the page or scene for 
helping to identify the purpose or contents of the page.

SPECIFY OFFSET Allows you to specify the time delay between the playout between the open 
page/scene and the next consecutive page/scene in the playlist.

DURATION Allows you to specify the amount of time the page or scene will remain on air. 
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NOTE

The name of the embedded page will be identical to the template name until you change 
the name in the page’s Name property field. 

Shared Page, Embedded Page and Scene icons

Since there is no way distinguishing which pages in the Playlist Editor are embedded pages 
or shared pages; opening a page in the Template Editor and verifying the icon in the upper-
right corner is the only way of identifying the page type.

The SHARED PAGE icon  indicates that the page that is open in the Template Editor is a 
shared page. Meanwhile, the EMBEDDED PAGE icon  indicates that the page that is open 
in the Template Editor is an embedded page.

Similarly, if the asset open in the Template Editor is a scene asset, the SCENE icon  is 
displayed in the upper-right corner of the Template Editor.
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Segment Editor toolbar
The toolbar along the top-left side of the Segment window contains a series of buttons that 
allow you to perform actions related to populating the rundown segment and performing 
basic actions on the existing segment.

The following table provides a functional description of each button on the Segment 
window’s toolbar:

 

CREATE NEW SEGMENT

When selected in the standalone Segment window, a new (empty) rundown segment 
is created, which can be populated and saved as a shared segment.

When selected in the Segment window associated with the Rundown Editor, a new 
(empty) rundown segment is created and added to the rundown. The default name of 
the segment, NEW SEGMENT, can immediately be changed by typing a new name in the 
Rundown Editor. You can then populate the segment with pages and save it as an 
embedded segment in the rundown, or use the SAVE CURRENT SEGMENT AS button to 
save it as a shared segment (see “Saving a rundown segment” on page 7-17). 

Alternative access:

• Menu command: FILE>NEW SEGMENT

• Keyboard shortcut: CTRL+T

 

SAVE CURRENT SEGMENT

Saves the current rundown segment in its current form (i.e. an embedded segment is 
saved as an embedded segment, and a shared segment is saved as a shared 
segment). Use the SAVE CURRENT SEGMENT AS button to save an embedded segment 
as a shared segment (see “Saving a rundown segment” on page 7-17). 

An asterisks next to the segment’s name indicates that edits have been made to the 
segment, but have not yet been saved.

Alternative access:

• Menu command: FILE>SAVE PLAYLIST

• Keyboard shortcut: CTRL+S
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SAVE CURRENT SEGMENT AS

Opens the SAVE SEGMENT dialog box, which allows you to:

• Save the currently open shared segment under a different name.

• Save the currently open embedded segment as a shared segment to be stored in 
the Asset Browser’s Segments root category.

Alternative access:

• Menu command (standalone only): FILE>SAVE SEGMENT AS

 

RELOAD

Reloads, or refreshes, the most recently saved version of the segment.

Reloading the segment is useful for:

• insuring that you have the most recent version of a segment. For 
example, if somebody else accesses and makes changes to the 
segment while you are have it open.

• quickly returning to the state that the segment was in when it was 
last saved after making unsaved and unwanted edits. 

Alternative access:

• Menu command: ACTIONS>RELOAD SEGMENT

• Keyboard shortcut: F5

 

INSERT NEW PAGE

Opens the SELECT A TEMPLATE FOR THE NEW GRAPHIC dialog box, which allows you to 
open and edit a page in the Template Editor. Once you have made the appropriate edits 
to the page, click the INSERT IN PLAYLIST AND CLOSE button  in the Template Editor’s 
toolbar to insert the new page into the segment.

 

VERIFY SEGMENT

Executes a manual segment verification to see if the items in the segment have been 
properly published to the devices selected in the Device for Verify drop-down list. 
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9 APPENDIX B - QUICK REFERENCE TO 
XBUILDER’S SETTINGS

Although Xbuilder’s default settings are appropriate for most operating circumstances, you 
may want to customize the look and behavior of the application using Xbuilder’s settings. 
Note that modifying these settings is entirely optional.

The following sections provide a quick reference description of all of Xbuilder’s settings:

• “General settings” on page 9-2

• “Display settings” on page 9-4

• “Template Favorites settings” on page 9-6

• “Automation settings” on page 9-7

• “Playlist Ingest settings” on page 9-8

• “Place Holders settings” on page 9-9

• “Merge List settings” on page 9-10

• “Logging settings” on page 9-11

• “Render To File settings” on page 9-12

• “Timelines settings” on page 9-13

• “Work Orders settings” on page 9-14

• “Servers settings” on page 9-15

• “Playlist > Basic settings” on page 9-16

• “Playlist > Highlight settings” on page 9-17



9-2 Xbuilder User Manual

Appendix B - Quick reference to Xbuilder’s settings 

General settings

Figure 9-1. General settings

• Startup panel - Specifies the panel that is loaded when Xbuilder is launched.

• Page life span - All pages have an expiry date. Once reached, expired pages are 
deleted from the system in order to keep the server from becoming clogged with pages 
that are no longer relevant. Use this field to enter the number of days before a page 
expires. If left at 0, the page never expires. If a page that already existed is edited, its 
expiry is reset to the number of days specified in this field. 

• Remove deleted pages on open - If a playlist includes deleted pages, selecting this 
option ensures that they will be deleted automatically the next time the playlist is 
loaded. Otherwise, the expired pages will be highlighted in red.

• Append date to page names - When selected, this setting adds the date to the asset 
name of the page that is being created/saved.

• Verify playlist - When set to AUTOMATIC, each element of the playlist is verified when 
they are loaded. When set to Manual, each element in the open playlist is verified when 
the VERIFY PLAYLIST button  is clicked in the Playlist Editor’s toolbar. In both cases, 
the result of the verification is displayed in the Status column of the playlist element. 
See “Verifying the contents of a playlist” on page 6-5 for more information.

• Number of Verify Devices - Determines the number of device rows that will be 
dedicated as Verify devices in Xbuilder’s Device Manager. See “Configuring a device 
for the verification of playlist elements” on page 2-9 for more information.

• Spell check on - When selected, the application helps you to avoid any typing error or 
spelling mistakes by underlining any potentially misspelled words that you have entered.

• Spell check color - Specifies the RGB color that the SPELL CHECK ON setting uses for 
the line color to identify potentially misspelled words.
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• Use default offset after zero duration - This setting affects the offset applied to 
playlist elements after edits. When the playlist is edited, the offsets of affected elements 
are adjusted to avoid any gaps in the playlist. The rule applied when setting the offset 
of a playlist element that follows a page element is to make the offset equal to the 
duration of the preceding page element. In cases where the duration of the preceding 
page element is zero then the USE DEFAULT OFFSET AFTER ZERO DURATION setting is 
consulted. If it is true, then an offset of 10 seconds is used, otherwise, an offset of 0 is 
used.

• SWCG Executable Location - The full path to the Software CG executable used to 
preview and/or render to the asset to an image or video file. Usually, the installer places 
the VertigoCG2L.exe file in the following directory: 
C:\Program Files\VertigoXmedia\Apps\VertigoCG2

• TV Format - When using a MergeList in Xbuilder to create a series of pages, the TV 
Format parameter ensures that the values that appear in the playlist’s Duration 
column are displayed using a consistent resolution format. For example, if the duration 
in the MergeList is 45 seconds for a 25 fps template, then the duration in the playlist 
will be 00:45.0 when TV Format is set to PAL and 00:37.15 when set to NTSC.



9-4 Xbuilder User Manual

Appendix B - Quick reference to Xbuilder’s settings 

Display settings
Although the Display setting page has various settings, the bulk of the settings deal with the 
OVERFLOW and UNDERFLOW properties, which are set on this page and reported in the 
Overflow column in the Playlist Editor.

At the center of the overflow/underflow discussion are TIMESLOTS. A timeslot is a set of 
playlist items between two hard-starts (a hard-start is a playout type for bringing playlist to 
air at a specific time). The total time available in the timeslot is determined by the difference 
of the two hard-start times. Ideally, the timeslot should be filled with enough content to 
exactly fill this time. 

Overflow (or underflow) refers to the difference between the total time of the content in a 
timeslot and the time available in the timeslot. When the total time of the content in a 
timeslot exceeds the time available, there is an overflow. Similarly, when the total time of 
the content in a timeslot is less than the time available, there is an underflow.

The overflow column in the playlist indicates if a timeslot has an overflow or an underflow. 
The time difference is displayed as a positive value for overflows and a negative value for 
underflows. Furthermore, it is possible to specify thresholds for overflow and underflow. 
When the overflow or underflow in a timeslot exceeds the threshold, the overflow column is 
colored to draw attention to the problem. 

Figure 9-2. Display settings

• Tile size for proxies - The size (in pixels) of proxies used in to display the assets in a 
category. 

• Overflow/underflow error color 1 - Specifies the color used to in the playlist’s 
Overflow column to indicate that a timeslot contains an overflow or underflow that 
exceeds acceptable thresholds. 
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• Overflow/underflow error color 2 - Specifies a second color used to indicate that a 
timeslot contains an overflow or underflow that exceeds acceptable thresholds. The 
need for a second/alternating color is to distinguish between successive timeslots that 
contain an error. 

• Normal status color 1 - Specifies a color used to in the playlist’s Overflow column to 
indicate that a timeslot does not contain an overflow or underflow that exceeds 
acceptable thresholds. 

• Normal status color 2 - Specifies a second color used to indicate that a timeslot does 
not contain an overflow or underflow that exceeds acceptable thresholds. The need for 
a second/alternating color is to distinguish between successive timeslots that do not 
contain an error. 

• Overflow tolerance - Specifies the threshold (in milliseconds) above which an 
overflow in a timeslot is considered an error. 

• Underflow tolerance - Specifies the threshold (in milliseconds) above which an 
underflow in a timeslot is considered an error. 

• Offset display format - Specifies how the Offset column of the playlist is formatted. 
The following settings are available: 

• STANDARD: When hard-starts are used, items display the time of day at which 
they will play. If there are no hard-starts, items display the time relative to the 
start of the playlist at which they will play. Secondary items display the time at 
which they will play, relative to the start of the primary item that contains them. 

• RAW: Displays the offset between the start of the playlist item and the 
preceding item. If the preceding item is a clip, the offset is with respect to the 
end of the clip (usually this value is zero). If the preceding item is a page, the 
offset is with respect to the start of the page, that is, when the page was taken. 
Normally, this value is equal to the duration of the preceding page. 
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Template Favorites settings
Rather than searching through the Asset Browser for a template, the Template Favorites 
settings allow you to assign a particular template to a control key sequence. This provides 
a convenient shortcut for opening frequently needed and used templates. The Template 
Favorites settings allows you to assign shortcut for up to (10) templates. 

Figure 9-3. Template Favorites settings

To assign a specific template to a control key sequence:

1. Open the Settings dialog box: TOOLS>SETTINGS

2. Select TEMPLATE FAVORITES from the tree menu in the left panel.

3. Click in the text box of one of the Control key sequence (i.e. Ctrl+1) rows that you want 
to assign the template to.

4. Press the  button next to the text box. 

The SELECT TEMPLATE dialog box appears.

5. In the SELECT TEMPLATE dialog box, navigate to the desired template. Select the 
template and click OK.

Now when you are working in Xbuilder and you press the Control key sequence, the 
template assigned to that shortcut will open in the Xbuilder content panel.
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Automation settings
Xbuilder automation settings allow you to determine whether or not you would like 
messages to display while working in Xbuilder. While these messages may become 
redundant, they often serve as an important confirmation step. Therefore, in most cases, 
we recommend that you leave these settings selected.

Figure 9-4. Automation settings

• Confirm page deletion - When selected, Xbuilder displays a confirmation message 
whenever you attempt to delete a page. When cleared, the message will not be 
displayed and the deletion process will execute immediately.

• Confirm playlist clear - When selected, Xbuilder displays a confirmation message 
whenever you attempt to clear a playlist. When this setting’s check box is cleared, the 
message will not be displayed and the playlist will be immediately cleared.

• Prompt for save on new playlist - When selected, Xbuilder displays a confirmation 
message requesting that you save any changes to the current playlist before closing it. 
When this setting’s check box is cleared, the message will not be displayed and the 
playlist will close without saving the most recent changes.
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Playlist Ingest settings
Xbuilder is able to generate playlists from a traffic file. The following settings are used to 
influence how this generation takes place. 

Figure 9-5. Playlist Ingest settings

• Default category for Clips - Specifies the category in which all clips used in the 
ingested playlist reside. When a clip name is encountered in the traffic file, a search is 
made for the clip in this category. This category is also used to hold place-holder clips 
when they need to be created. During the ingest process, the traffic file may refer to 
clips that are not present. When this occurs a place-holder clip is created in the 
specified category and an associated WorkOrder Job is created. 

• Default category for Pages - Specifies the category in which all pages used in the 
ingested playlist reside. When an Action is encountered in the traffic file, a search is 
made for a page with the same name in this category. 

• Default category for Templates - Specifies the category in which all templates used 
in the ingested playlist reside. When a Live Event is encountered, a search is made for 
a template with the same name in this category. When an Action is encountered in the 
traffic file, a search is first made for a page with the same name. If that search fails, 
then a second search is made for a template with the same name in this category. 

• Default Secondary Event Template - Specifies the default template to use for an 
Action when no page or template could be found.

• Path for error log - Specifies the directory in which the ingest log file is written. The 
ingest log file contains a record of what happened during the playlist ingest. It can be 
consulted to see if any errors occurred. 

• Tolerance for too long clips - Specifies a time value (in milliseconds). The maximum 
value by which the actual duration of a clip can differ from its reported duration in the 
traffic file. If the difference between the actual clip duration and the reported clip 
duration exceeds this tolerance, (either too short or too long), then the clip is 
considered invalid. Xbuilder will display a message box upon completion of the ingest 
if any invalid clips are encountered. 
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Place Holders settings
Within a WorkOrder Job, a place holder can be created for an image or clip. A place holder 
is an empty asset that serves as a place holder for an image or clip that will be obtained 
later by completing the associated WorkOrder Job.

Figure 9-6. Place Holders settings

• Images place holder default category - Specifies the category in which new image 
place holders are saved. If unspecified, image place holders are saved to in the same 
category as the image from which the place holder is created. 

• Clips place holder default category - Specifies the category in which new clip place 
holders are saved. If unspecified, clip place holders are saved to the same category as 
the clip from which the place holder is created. 
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Merge List settings
The properties on the Merge List settings page determine the default categories in which 
new pages and scenes are placed when they are created using a Merge List. Note that new 
scene are first placed in a temporarily category until they are approved, then they are 
moved to the scene category. New pages do not go to a temporary category, rather they go 
directly to the default category specified in the Merge List settings. See “Creating pages 
and/or scene using a Merge List” on page 3-4 for full details and instructions.

Figure 9-7. Merge List settings

• Merge List default page category - Select the  button to open the SELECT A 
CATEGORY window. Then select a destination category or sub-category where all new 
pages will be stored once created using the Merge List file.

• Merge List default scene category - Select the  button to open the SELECT A 
CATEGORY window. Then select a destination category or sub-category where the 
approved scenes will be stored.

• Merge List temporary scene category - Select the  button to open the SELECT A 
CATEGORY window. Then select a destination category or sub-category where the new 
scenes will be stored temporarily until they are approved, in which case they will be 
moved to the category specified in the Merge List default scene category setting. 
Rejected scenes will remain in this temporary category.
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Logging settings
Xbuilder offers several logging options that you can use for observing Xbuilder’s behavior and/or 
troubleshooting unexpected problems. The Xbuilder log files are saved in the following directory: 
C:\ProgramData\VertigoXmedia\Logs

Figure 9-8. Logging settings

• Rollover count - The rollover count determines the number of Xbuilder*.log files 
kept in the logging folder. Choose a large enough number so that enough relevant log 
files are stored. This helps to identify of repetitive behaviors and facilitates 
troubleshooting.

• Log file size (bytes) - The maximum size of a log file before starting over from the 
beginning.

• Log level - Xbuilder can be set to provide the following levels of logging events:

• Error – A major failure that impacts the end-user.

• Warn – An important but non-fatal error.

• Info – A useful notification message to help users troubleshoot/track issues.

• Enable Debug Logging - Select the  button to open the VERBOSE LOGGING window, 
which is used for selecting which categories of information, processes and errors to 
record in the log files. 
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Render To File settings
Xbuilder offers a variety of rendering profiles which allow you to render templates, pages or 
scenes to files that can be stored on your system. Full details and instruction for rendering 
to file are available on page 4-1. 

Figure 9-9. Render To File settings

• Default Profile Path - (To be used in Windows7 only) Identifies the path to the folder 
where the Pipeline profile files can be found. Normally, the Vertigo Suite installer stores 
these files in the following directory: 
C:\Program Files(X86)\MirandaTechnologies\Vertigo Render To File. 
Once you specify the path, you must click OK and restart Xbuilder for the profiles to 
populate the Default Profile settings drop-box.

• Default Profile - (To be used in Windows7 only) If you do not explicitly choose one in 
the Render To File window, the default profile selected in this setting will be used to 
render the asset to a file. The drop-box is populated based on the files located in the 
folder defined by the DEFAULT PROFILE PATH setting. Current profiles include:

• MPEG2 (mp2 audio) HD
• MPEG2 (mp2 audio) SD
• MXF IMX 25 (PCM audio) 
• MXF IMX 30 (PCM audio) 
• MXF IMX 40 (PCM audio) 
• MXF IMX 50 (PCM audio)
• MXF MPEG2 (PCM audio) HD
• MXF MPEG2 (PCM audio) SD
• MXF XDCAM HD-50 (50 Mbit 4:2:2) (PCM audio)
• VAF HD
• VAF SD

• Default Render Path - Allows you to specify the default folder on your system where 
the file will be rendered to.

• Default Duration - The default duration of the file to be generated. If the duration is 0, 
the clip will be rendered for 1 second.
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Timelines settings
Xbuilder’s Timelines settings support the creation and definition of auto promo timelines.

Figure 9-10. Timelines settings

• SHOW FULL TIMELINE NAME - Determines if the fully qualified name of the timeline, 
including its category, or the short name of the timeline, without its category, is 
displayed above the timeline editing area.

• DEFAULT FADE IN DURATION (SEC) - Specifies the default fade in duration used in newly 
created timelines. 

• DEFAULT FADE OUT DURATION (SEC) - Specifies the default fade out duration used in 
newly created timelines. 

NOTE

The durations are specified in seconds, since timelines may use a variety of video formats, 
with different frame rates. 
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Work Orders settings
Xbuilder’s WorkOrders settings support the behavior and management of work orders and jobs.

Figure 9-11. Work Orders settings

• ROWS IN WO JOB LIST - This setting determines the number of rows are always visible 
in the job list portion of the Work Order window. Since most work orders contain a small 
number of jobs, the default value of 3 is reasonable. If there are more than three jobs 
in the work order, you can always scroll down through the list to view the additional 
jobs. If you routinely add numerous jobs to a work order, this setting can be set to a 
larger number so that you can see all the jobs without having to scroll. Note that the 
minimum permitted value is 3 and the maximum permitted value is 10.

• HIGHLIGHT OVERDUE WO - Highlights work orders that are past their due date in red.

• WO DUE DATE TOLERANCE (DAYS:HOURS) - Sets the tolerance for whether a work order 
is identified as being overdue and consequently highlighted in red if the HIGHLIGHT 
OVERDUE WO setting is enabled. The format of the this setting value is DAYS:HOURS. 
For example, a tolerance value of 1:18 translates to one day and eighteen hours can 
go by before the work order is flagged as being overdue.
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Servers settings
The Servers settings specify the locations of the Xmedia Server and the Data Server. The 
XmediaServer contains all assets, i.e. all building blocks used in the creation of broadcast 
graphics. This is where playlists, templates, images, etc., are stored. The Data Server is an 
application that manages all data coming in from sources specified in templates. The Data 
Server distributes the data and provides live updates of data values when requested.

Figure 9-12. Servers Settings dialog box

• XmediaServer IP Address - Specifies the IP address of the machine running the 
XmediaServer. 

• XmediaServer Port - Specifies the port on which the XmediaServer is listening.

• Backup XMedia Server IP Address - Specifies the backup server’s IP address used 
in case of failure of the primary Xmedia Server.

• Backup XMedia Server Port - Specifies the backup server’s port used in case of 
failure of the primary Xmedia Server.

• Data Server IP Address - Specifies the IP address of the Data Server.

• Data Server Port - Specifies the port on which the Data Server is listening.

• Backup Data Server IP Address - Specifies the backup data server’s IP address used 
in case of failure of the primary data server.

• Backup Data Server Port - Specifies the backup data server’s port used in case of 
failure of the primary data server.

NOTE

To access the Xmedia Server and Data Server interfaces, select START>SETTINGS>CONTROL PANEL. 
Then select the VERTIGOXMEDIA DATA SERVER or VERTIGOXMEDIA XMEDIA SERVER icons.
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Playlist > Basic settings
Playlist basic settings determine colors for everything in your playlist -- pages, actions, 
segments, comments and titles. Click the  button to the right of each color field to display 
a color selection dialog box. You can also choose a font for the playlist.

Figure 9-13. Basic Settings

• Title Color - Specifies the background color of the playlist header row.

• Title Text Color - Specifies the text color of the playlist header row.

• Page Color - Specifies the background color of a page in the playlist.

• Page Text Color - Specifies the text color of a page in the playlist.

• Action Color - Specifies the background color of an action in the playlist.

• Action Text Color - Specifies the text color of an action in the playlist.

• Segment Color - Specifies the background color of a playlist segment.

• Segment Text Color - Specifies the text color of a playlist segment.

• Comment Color - Specifies the background color of a playlist comment.

• Comment Text Color - Specifies the text color of a playlist comment.

• Main Font - Specifies the font to be used throughout the playlist.

• Show hours in duration column - Determines how the duration values are displayed 
(i.e. hours, minutes, seconds, frames). When selected, the duration values are 
displayed using the following format: MM:SS.FF. However, if the duration exceeds one 
hour, the duration value is shown in an HH:MM:SS.FF format. For example 01:12.23. 
If this setting is not selected, durations values are always shown in HH:MM:SS.FF 
format. For example 00:01:12.23.
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Playlist > Highlight settings
Playlist highlight settings determine colors for playlist items that are currently in the process 
of being edited. Click the  button to the right of each color field to display a color selection 
dialog box.

Figure 9-14. Highlight settings

• Insert Line Color - When an item is being dragged to a new position in the playlist, the 
insert line indicates where the item will be placed once the mouse key is released, and 
whether or not it is being placed within a segment (refer to the note below). An insert 
line that runs the entire width of the playlist indicates that the item is being moved 
outside of a segment. If the line does not run the entire width, the item is being moved 
within a segment.

• Select Color - Specifies the background color of a selected playlist item.

• Select Text Color - Specifies the text color of a selected playlist item.

• Segment Selected Text Color - Specifies the color used to draw the segment name 
in a segment that is selected. We recommend choosing a color that contrasts with the 
Segment Selected Color so the text will be visible. 

• Segment Drag Over Color - Specifies the background color of the segment heading 
when an item is being dragged into it.

• Edit Color - Specifies the background color of a playlist cell when its contents are being 
edited.

• Edit Text Color - Specifies the text color of a playlist cell when its contents are being 
edited.
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